
 

 

THE WORLD OF CAD AND PDM SOLUTIONS 

 

 

 

 

 

 

 

 

2013  
 

 

 

 
HiCAD/HELiOS 

Getting started 
     System requirements 
     Installation guide 
             Licensing 
          Update Information 
              First Steps 
                  News 



  

 2 UNLIMITED PERFORMANCE 

Legal notes 
© 2013 ISD ® Software und Systeme GmbH. All rights reserved. 

This User Guide and the software described herein are provided in conjunction with a license and may only 
be used or copied in accordance with the terms of the license. The contents of this User Guide solely serve 
the purpose of information; it may be modified without prior notice and may not be regarded as binding for 
the ISD Software und Systeme GmbH. The ISD Software und Systeme GmbH does not assume any 
responsibility for the correctness or accuracy of the information provided in this document. No part of this 
document may be reproduced, saved to databases or transferred in any other form without prior written 
permission by the ISD Software und Systeme GmbH, unless expressly allowed by virtue of the license 
agreement.  

All mentioned products are trademarks or registered trademarks of their respective manufacturers and 
producers. 

 

The license management portion of this Licensee Application is based upon one or more of the following 
copyrights: 

Sentinel®RMS 
© 1989-2006 SafeNet, Inc. 
All rights reserved. 
 
Sentinel®EMS™ 
© 2008-2009 SafeNet, Inc. 
All rights reserved. 
 
Sentinel® is a registered trademark of SafeNet, Inc.   

 

This work contains the following software owned by Siemens Industry Software Limited: 

D-CubedTM 2D DCM © 2013. Siemens Industry Software Limited. All Rights Reserved. 

D-CubedTM 3D DCM © 2013. Siemens Industry Software Limited. All Rights Reserved 

D-CubedTM AEM © 2013. Siemens Industry Software Limited. All Rights Reserved. 

 

PDF3D® 

© 2003-2011 Visual Technology Services Ltd. All rights reserved. Is a registered trademark of Visual 
Technology Services Ltd. 
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Copyright 2008, Google Inc. 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 
the following conditions are met: 

    * Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

    * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

    * Neither the name of Google Inc. nor the names of its contributors may be used to endorse or promote 
products derived from this software without specific prior written permission. 

 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS"AS IS" AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT 
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY 
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

Code generated by the Protocol Buffer compiler is owned by the owner of the input file used when 
generating it.  This code is not standalone and requires a support library to be linked with it.  This support 
library is itself covered by the above license. 
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1 System Requirements 
1.1 Hardware Requirements for HiCAD 
For the installation of HiCAD you can use any hardware that possesses current drivers 
for the operating systems used. Please note, for instance, that the graphics card drivers 
need to support the complete OpenGL instruction set.  

» Hardware requirements (minimum): 

 Pentium 4 compatible processor with SSE2 support 

 4 GB RAM 

 approx. 3 GB disk free space 

 DVD drive 

 Screen resolution of 1280 x 1024  

 Fully OpenGL capable graphics card with at least 128 MB memory (if the error 
message Set Pixel Format failed is issued during program start, the OpenGL driver 
does not support the entire instruction set). You can use the 
OpenGLCapabilityTester to check whether the OpenGL capabilities of your 
computer are sufficient for HiCAD. This tool is available for download in the ISD 
Wiki at FAQ > System Requirements > HiCAD. 

 To achieve optimal performance for large assemblies, the system should possess 
significantly more main memory than is considered sufficient for HiCAD at first glance. This 
enables the hard disk accessing operations Buffer memory, Undo and Switch drawing to be 
performed up to 4 times faster. 

 

» Supported operating systems: 

 Windows 8 

 Windows 7 (with current service pack and security patches) 

 Windows XP (with current service pack and security patches) 

http://www.hicad.isdgroup.de/cms/dofiles/f_2402_865111e944a215c345d37ddd03418326_0_openglcapabilitytesterpzip.zip
https://wiki.isdgroup.com/download/attachments/32374804/OpenGLCapabilityTester.exe
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» Supported database systems (for HiCAD with HELiOS): 

 Microsoft SQL Server 2000 / 2005 / 2008 / 2012  

 Oracle Database Server 10g / 11g R2 

There are no further requirements for the installation of the HiCAD Version with License 
Management; the legal licensing check is performed during runtime.  

» Optimal hardware equipment (January 2013):  
 

Computer: Fujitsu Celsius M470 

Processor (CPU): Intel® Xeon® Processor W3550 (8M Cache, 3.06 GHz, 
4,80 GT/s Intel® QPI)  

RAM: 16 GB, DDR3-RAM, 1333 MHz 

Hard disk: 1 SATA II disk (hard disk: Windows),  
1 SSD SATA disk, 128 GB, 2.5 inch (hard disk: HiCAD) 

Screen resolution Full HD (1920x1080) 

Graphics card: NVIDIA Quadro 5000 (2.5 GB) 

Operating system: Windows 7 (64 Bit)  

» Graphic cards 
The following graphic cards are recommended for HiCAD operation (tested on 
Windows 7  

Supplier Model Graphic drivers (tested) 

Nvidia NVIDIA Quadro 2000 (1 GB) 8.17.12.9670 (296.70) 

 NVIDIA Quadro 4000 (2 GB) 8.17.12.9670 (296.70) 

 NVIDIA Quadro 5000 (2.5 
GB) 

8.17.12.9670 (296.70) 

AMD FirePro V3900 (1 GB DDR3) 8.911.3.3000 

 FirePro V5900 (2 GB 
GDDR5, 512 Stream-Proc.) 

8.911.3.3000 
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 Please note that insufficient graphics hardware will impair the performance and the 
quality of graphical representation! 

 

1.2 System Requirements for HELiOS Desktop (Standalone) 
For the installation of HELiOS you may use any hardware possessing current drivers for 
the operating systems used. Please note, for instance, that the graphics card drivers 
need to support the complete OpenGL instruction set.   

» Hardware requirements: 

 Pentium 4 compatible processor with SSE2 support 
 1 GB RAM 

» Supported operating systems: 

 Windows XP (with current service pack and security patches) 
 Windows 7 (with current service pack and security patches) 
 Windows 8 

» Supported database systems:  

 Microsoft SQL Server 2000 / 2005 / 2008 / 2012  
 Oracle Database Server 10g / 11g R2  

» Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to 
be installed on the computer before HELiOS can be used; these packages will be 
installed by the HELiOS installer if required. 

» To be able to work with the HELiOS Desktop, one of the above mentioned database 
systems needs to be available and prepared for the use of HELiOS. Installation 
instructions (in .pdf format) and appropriate implementation of the server system can 
be found in the Readme directory of the HELiOS Installation DVD.  
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1.3 Hardware Requirements License Server 
 

Processor (CPU): x86 Processor for 32-Bit / x86-64 Processor for 64-Bit 

Recommended: 2 GHz Processor 

RAM: Minimum: 1 GB  

Recommended: 2 GB (with SQL Server: > 3 GB ) 

Hard disk: 1.2 GB free disk space 

Operating System 
(Server) 

Windows Server 2003 (32 & 64-Bit) 

Windows Server 2008 (32 & 64-Bit) 

Windows Server 2008 R2 (32 & 64-Bit)  

Windows Server 2012  

Operating System  
(Client) 

Windows XP (32 & 64-Bit)  

Windows Vista (32 & 64-Bit) 

Windows 7 (32 & 64-Bit) 

IP/MAC Adress A static IP address is required for an error-free 
operation of the license server. 

For virtual servers a static MAC address needs to be 
available. 

 

 A license server program does not need to run on a file server system or any specific 
hardware server. Suitable is any computer that fulfils the requirements.  
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1.4 Hardware Requirements HiCAD Spooler 
The system requirements for the Plot Spooler are identical to those for a normal HiCAD 
Client (please see System Requirements for HiCAD). The RAM should be at least as 
large as the RAM for the existing HiCAD Clients. The reason for this is that the Plot 
Spooler must be able to perform, besides automation tasks, various other tasks such as 
the conversion of HiCAD drawings (to 3D-PDF or similar).  

Besides the Client operating systems Windows 7 und XP you can also use the Server 
operating systems Windows Server 2003, Windows Server 2008 or Windows Server 
2012. Whether a Server operating system needs to be used depends on the licensing 
conditions for the Microsoft operating system that you use. The decisive factor is the 
number of permitted simultaneous device connections. For Windows XP the number is 
limited to 10, for Windows 7 it is limited to 20 connections.  

 



System Requirements 

 16 UNLIMITED PERFORMANCE 

1.5 Hardware Requirements Vault Server 
 

Processor (CPU): Pentium III-compatible processor, Minimum: 1,0 GHz 

RAM: Minimum: 1 GB, Recommended: 4 GB or more 

Graphics Card: VGA (no special requirements) 

Hard disk: For software: 100 MB 

For user data: Depending on the amount of data to be 
expected, plus backup memory of >= 100%  

(distribution over several volumes/drives possible, 
redundant array of independent disks (RAID) for primary 
user data recommended) 

Operating system 
(virtual servers also 
possible): 

 

Windows XP SP3 Professional 
Windows XP SP2 x64 Professional 

Windows 7 Professional 
Windows 7 x64 Professional 

Windows Server 2003 SP2 
Windows Server 2003 SP2 x64  

Windows Server 2003 R2 SP2 
Windows Server 2003 R2 SP2 x64 

Windows Server 2008 SP2 
Windows Server 2008 SP2 x64  

Windows Server 2008 R2 x64  

Windows Server 2012 
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1.6 Further Installation Requirements 
» Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to 

be installed on the computer before HiCAD/HELiOS 2013 can be used; these 
packages will be installed as part of the HiCAD installation if required.  

» The graphics card must support Open GL 2.0 or higher. If the hardware or driver 
does not support this standard, there will be shown a warning message when 
installing HiCAD and a compatibility mode will be used (with low graphic 
performance). 

» If you use Nvidia graphics drivers, the Common background/Z-buffer needs to be 
switched Off (in contrast to HiCAD 2007 or older versions).  

» To be able to work with HELiOS, a database system must be available that has been 
prepared for HELiOS. Documents (in .pdf format) describing the installation 
procedure for the database system and the import and export of the database can be 
found in the Readme directory of the Installation DVD.   

» To be able to work with HELiOS, a database system must be available that has been 
prepared for HELiOS. For this you require 

 A Microsoft SQL Database Management system on your Server, 

 A HELiOS database imported with the HELiOS Database Creator and  

 An ODBC connection on the Clients. 

 Documents (in .pdf format) describing the installation procedure for the database 
system and the import and export of the database can be found in the Wiki at 
Product Know-how > Documentation > HELiOS.  

 

» Current information on system requirements can also be found on the Internet at 
www.isdgroup.com at Support > ISD Wiki > Product know-how  > FAQ. 
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2 Installation 
The DVD contains the installation files for:  

» HiCAD 

» HELiOS Desktop (Standalone) 

» The Online Help  

» The Vault Server 

» The Plot Management  

» HiCAD Viewer 

» The License Server (the Hardlock driver is normally no longer required) 

» The PostScript printer driver (required for the output of several views to a PDF file) 

» The HELiOS Database creator (to set up the HELiOS database for the very first time 
and import/export an existing database) 

The DVD has been developed for Windows operating systems. When you insert the 
DVD, an installation wizard will be started automatically. 

 

 The HiCAD and HELiOS version must be installed on the hard disk of the computer; it is 
not possible to start the programs from the DVD. 
 

If the Autostart function has been deactivated in the operating system, it is mandatory 
for the installation of HiCAD to start the setup.bat file from the root directory of the DVD; 
only in this way it is ensured that the version of the operation system (32/64Bit) will be 
recognised correctly, and the matching HiCAD version will be installed.   
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In the installation wizard, click the Standard Edition button, which opens a mask with 
various selection options for software components.   

 

Leave this selection mask open, so that you can, one after the other, select the desired 
components.  
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2.1 Installing HiCAD 

 

Click the HiCAD and HELiOS button to start the installation.  

Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to be 
installed on the computer before HiCAD/HELiOS can be used; these packages will be 
installed as part of the HiCAD installation if required.  
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First, important information about data compatibility will be displayed. Please read this 
information carefully. 
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Specify an installation directory.  

 

 

You can help us increase the user-friendliness of our products even further. To 
participate or terminate your participation, please activate the corresponding checkbox. 

You can terminate your participation at any time by choosing Help > Customer 
Feedback, and selecting the corresponding checkbox.  
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Data Protection notice: Collection of Data for Constant GUI Optimisation 

You can help us increase the user-friendliness of our products even further. If you 
participate, the ISD will collect information on your use of our software, in order to 
detect trends and use patterns.  This information will then be used for a constant 
optimisation of our user interface, with the aim to make the operation of our software as 
convenient and efficient as possible for our users. 

 
The collected information  

» Contains data on the functions that you used (frequency and chronological order). 

» Contains a key enabling the identification of your computer. It does not contain any 
personal data, and will not be used to detect your identity. The key will only be used 
to obtain data on the diffusion rate of customer feedback. For instance, it is important 
to know whether a functionality has been used 100 times by 1 customer, or whether 
another function has been used only once by 100 customers etc. 

» Will be automatically removed after transmission to the ISD.  In case of a failed 
transmission (e.g. because of network problems) the information will be automatically 
removed after 1 week at the latest when the program has been re-launched. 

» Will not cause a slowing down of the program operation. 

 
ISD will not 

» Store your name, address, or any other personal data. 

» Ask any further questions besides asking for your consent to the participation. 

» Use the data for any other purposes than those described above. 

» Contact you in any form in connection with your participation. 

 
You can choose to participate when installing the product for the first time. To terminate 
your participation at a later time, choose Help > Customer Feedback, and select the 
corresponding option.  
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Please read the Notes on Hardware exchange carefully. 

Notes on Hardware Exchange 

If you use local HiCAD/HELiOS/HELiCON licenses and want to exchange any hardware 
components, modify the partitioning of, or re-install the operating system, you need to 
revoke the existing license on the HiCAD workstation first, and request, using the new 
hardware or modified configuration, a new license key (further information on the 
procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the 
right to charge costs in an appropriate amount for the reissuing of the license. If the 
license will not be revoked, or if such revocation is no longer technically possible, the 
ISD may request proof that the unrevoked license is no longer utilisable; in case of 
failure to produce such proof, the ISD reserves the right to refuse the transfer of the 
license to a new hardware.  

Accept the notes to continue with the installation. 
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You can now start with the installation or modify the Extended Settings, e.g. for the user 
configuration, the catalogues, or HiCAD with HELiOS.  

 

In the Configuration Database, customer-specific settings for various features such as 
dimensioning, annotations, workshop drawing creation or fitting of vertical ladders are 
stored. When making an update, customer-specific settings can be applied. In addition, 
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values that have not been modified by the user will automatically obtain the updated 
pre-settings.  

Depending on the selection in this window, the settings stored in the CSV file, too, will 
be applied. The standard CSV files are located in the templates directory of the HiCAD 
installation. CSV files are configuration templates that you can create and edit with 
Microsoft Excel (please see Online Help). 

Parameter configuration: No templates (see 2.6 Parameter Configuration) is activated 
by default. You can also change this setting subsequently, via the programs 
..exe/ParKonfigComp.exe (for the workstation) and ..exe/ParKonfigUser.exe (for the 
User). 

 

The execution of the CatalogueMaker serves the purpose of specifying which standard 
series are to appear in the standard part catalogues (currently standard series are 
available for DIN, ISO, EN, ANSI and JIS); the selection of standards in the 
CatalogueMaker only influences the display of standard parts, but not their availability; 
the availability is still controlled via license selection in the ISD License Manager.    

When Updates are made, the existing configuration will be applied, and the 
CatalogueMaker will not be started automatically. If you want to add standards to the 
catalogues, the program can be called via Start > All Programs > ISD Software und 
Systeme GmbH > Administration.  
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In case of a new installation you can specify an arbitrary name for the system data 
source. In case of an update, the existing data source will be offered. User and 
Password will be identical with the ODBC login.  

If you want to process your print jobs via the ISD Plot Management, you need to install 
one PrintClient on each workstation. In the Server field, enter the network name of the 
computer on which the Spooler is installed. The Spooler collects the print jobs and 
processes them, taking your settings into account.  
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The availability of interfaces with HELiOS depends on the programs that are installed on 
your computer. You can only link 32Bit versions to HELiOS 32Bit versions, and only link 
64Bit versions to HELiOS 64Bit versions.Multiple selections are also possible. The 
HELiOS functions will be integrated in the programs that are linked to HELiOS. 

 A compatibility matrix for the CAD systems can be found in the ISD Wiki at 
Product Know-how > FAQ > System & Hardware > HELiOS Desktop. 

 

 

You use the the License Administration Tools for the installation of server licenses.  

 Click Save to save the Extended Settings to an INI file. If you place the INI file in the 
installation directory when installing server licenses, the settings will be applied.  

As soon as you exit the Extended Settings dialogue with OK, the installation will be 
started. 
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Click Finish to complete your HiCAD installation. If desired, you can use the buttons of 
the installation mask to install further software components.  
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2.2 Installing HELiOS Desktop (Standalone) 
The HELiOS Desktop is normally installed automatically when you install HiCAD. Of 
course, you can also install HELiOS separately. To do this, start Windows. If Windows is 
already open, close all other applications. Insert the HELiOS DVD in your DVD drive. 
The installation wizard will be started automatically. Follow the instructions on the 
screen.  

 

In the installation wizard, click the Standard Edition button, which opens a mask with 
various selection options for software components. Please leave this selection mask 
open, so that you can, one after the other, install the desired components.  

 

Click the HELiOS button. 
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Please read the Notes on Hardware Exchange carefully. 
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Notes on Hardware Exchange 

If you use local HiCAD/HELiOS/HELiCON licenses and want to exchange any hardware 
components, modify the partitioning of, or re-install the operating system, you need to 
revoke the existing license on the HiCAD workstation first, and request, using the new 
hardware or modified configuration, a new license key (further information on the 
procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the 
right to charge costs in an appropriate amount for the reissuing of the license.  If the 
license will not be revoked, or if such revocation is no longer technically possible, the 
ISD may request proof that the unrevoked license is no longer utilisable; in case of 
failure to produce such proof, the ISD reserves the right to refuse the transfer of the 
license to a new hardware. 

Accept the notes to continue with the installation. 

 

 

You can now start with the installation or modify the Extended Settings, e.g. for HELiOS. 
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In case of a new installation you can specify an arbitrary name for the system data 
source. In case of an update, the existing data source will be offered. User and 
Password will be identical with the ODBC login.  

 

The availability of interfaces with HELiOS depends on the programs that are installed on 
your computer. You can only link 32Bit versions to HELiOS 32Bit versions, and only link 
64Bit versions to HELiOS 64Bit versions.Multiple selections are also possible. The 
HELiOS functions will be integrated in the programs that are linked to HELiOS.  
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 A compatibility matrix for the CAD systems can be found in the ISD Wiki at Product Know-how > 
FAQ > System & Hardware > HELiOS Desktop. 

 

 

You require the License Administration Tools for the installation of server licenses.  

Click Save to save the Extended Settings to an INI file. If you place the INI file in the 
installation directory when installing server licenses, the settings will be applied.  

As soon as you exit the Extended Settings dialogue with OK, the installation will be 
started. 
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After successful installation, you will find the HELiOS shortcut on the Desktop for 
program launch.  

2.3 Installing the Online Help  
The Online Help is available locally (status of the date of installation DVD creation) and 
on the Internet (regularly updated) at www.help.isdgroup.com. Both versions of the 
Help can be directly launched from HiCAD. Please note that corresponding login data 
are required to access the Internet version of the Help.  

Start Windows to install the Help. If Windows is already open, close all other 
applications. Insert the DVD in the drive, which automatically starts the installation 
wizard. In the installation wizard, click the Standard Edition button, which opens a 
mask with various selection options for software components. Please leave this selection 
mask open, so that you can, one after the other, install the desired components. 

 

Click the HiCAD and HELiOS Help button. 

http://www.help.isdgroup.com/
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Specify the installation directory for HiCAD/HELiOS. 
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After successful installation, the Help can be found in the program folder and can be 
called via HiCAD/HELiOS.  
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2.4 Installing the Vault Server  
Start Windows to install the Vault Server. If Windows is already open, close all other 
applications. Insert the DVD in the DVD drive, which automatically starts the installation 
wizard. In the installation wizard, click the Standard Edition button, which opens a 
mask with various selection options for software components. Please leave this selection 
mask open, so that you can, one after the other, install the desired components. 

 

Click the HELiOS Vault Server button. 
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Specify the installation directory of the Vault Server. 

 

Give the Vault Server a name, e.g. the name of your company, plus the location of your 
company. This name will be shown, for example, when you connect to the Vault Server 
from the Vault Client.  
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The Vault Server renames all documents that are managed in the database (e.g. SZA, 
DOC, XLS, …) to *.VDF. These VDF files are saved to the Document directory.  

The files stored in the Management directory contain the assignments of the VDF file 
names to the ‚original file names‛.   

Log files (*.LOG) are saved to the Log directory. They record each access to the VDF 
files. 

Enter the name of the log file in the Log file name field. The name of the Vault Server 
would also be possible here. If the log file exceeds a certain length, it will be cut down 
and suffixed by the current date. 



Installation 

 42 UNLIMITED PERFORMANCE 

 

Click the Install button.  

 

Click Finish to complete the installation of the Vault Server. You can now install further 
components offered in the selection mask if desired. 
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2.5 Installing the HiCAD Spooler  
The Plot Management consists of the following two components: 

» HiCAD PrintClient (part of the HiCAD installation; is installed on each workstation) 

» HiCAD Spooler (is installed on the Server only) 

Start Windows to install the components of the plot management. If Windows is already 
open, close all other applications. Insert the DVD in the DVD drive, which automatically 
starts the installation wizard. In the installation wizard, click the Standard Edition 
button, which opens a mask with various selection options for software components. 
Please leave this selection mask open, so that you can, one after the other, install the 
desired components.  

 

 If you use Windows XP, Service Pack 3 is required for the Spooler. 

 

 

Click the HiCAD Spooler button. 
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First, important information about data compatibility will be displayed. Please read this 
information carefully. 
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Specify the installation directory for the software. 

 

Please read the Notes on Hardware Exchange carefully. Accept the notes to continue 
with the installation.  
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You can now click Install to start the installation, or modify the Extended settings, e.g. 
for the user configuration or the catalogues. The Extended Settings here are modified in 
the same way as the Extended Settings for the HiCAD. 

Then click Install. 

 

After successful installation, the HiCAD Spooler will be located in the program folder.  
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2.6 Parameter Configuration 
HiCAD provides suitably customised interfaces and configurations for various fields of 
engineering, e.g. for Mechanical Engineering, Steel Engineering, Metal Engineering or 
Plant Engineering. You can select these options during the installation of HiCAD 
(Extended Settings > User Configuration > Use ISD Standard Templates).  

To change the parameter configuration subsequently, start the programs 

» ..exe/ParKonfigComp.exe for the workstation configuration, and 

» ..exe/ParKonfigUser.exe for the user configuration. 

 

In the dialogue window you have the following setting options:  

» Module 
Here you choose the required filed of engineering. The common HiCAD parameters 
are then configured for this area. 

» Font 
Specifies the text font default setting, e.g. for dimensioning, title blocks, view 
labelling, annotation etc. 
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» HiCAD/HELiOS Default Solution 
Provides you with a preconfigured database solution for a safe and convenient 
management of product data. If you want to use it, activate the checkbox.  

» Attribute configuration according to DSTV  
If you want the HiCAD attribute masks for parts and drawings to obtain the DSTV-
relevant attributes, please activate the appropriate checkbox. The files 
BRW_3DTEIL.HDX and BRW_SZENE.HDX in the HiCAD SYS directory will be preset 
for DSTV BOM configuration.  

» ISD standard template; Module: Steel Engineering: 
 

Short description Default  HiCAD configuration file  Line 

General: Zoom factor <F2>-Zoom 5.0 sys\grapar.dat 50 

General: Zoom window size <F2>-
Zoom 

0.9 sys\grapar.dat 52 

Type of weight calculation for 
beams+profiles  (1 = Exact volume * 
Density, 2 = DIN weight, Commercial 
weight) 

2 sys\stb_parameter.dat 9 

Type of weight calculation for 
plates+sheets (1 = Exact volume * 
Density, 2 = Length*Width*Thickness 
* Density) 

2 sys\stb_parameter.dat 9 

Representation of beams + profiles  
(0 = Simplified, 1 = Exact, 2 = Axis 
only) 

0 sys\stb_parameter.dat 19 

First Steel Engineering part item 
number 

100 sys\stb_parameter.dat 31 

Type of detection for first item 
number of main parts and sub-parts 
(1 = Start value, 2 = Factor, 3 = 
Allowance) 

3 sys\stb_parameter.dat 34 

Itemisation of Standard Parts (0 = No, 
1 = Yes) 

1 10000 sys\stb_parameter.dat 38 

Itemisation of non-Steel Engineering 
parts (0 = No, 1 = Yes) 

1 10000 sys\stb_parameter.dat 40 
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Short description Default  HiCAD configuration file  Line 

Consider boltings for identical part 
search 

1 sys\stb_parameter.dat 55 

Handling of existing item numbers 
when inserting Steel Engineering 
parts 

1 sys\stb_parameter.dat 86 

Consider part attributes for identical 
part search (0 = No, 1 = Yes) 

1 sys\stb_parameter.dat 126 

Consider database part master for 
identical part search (0 = No, 1 = 
Yes) 

1 sys\stb_parameter.dat 128 

Set negative item number for 
modified Steel Engineering parts  

1 sys\stb_parameter.dat 143 

Increment for assembly item numbers 1 sys\stb_parameter.dat 151 

Increment for Steel Engineering part  
item numbers 

1 sys\stb_parameter.dat 153 

Increment for Standard Part item 
numbers 

1 sys\stb_parameter.dat 155 

Increment for non-Steel Engineering 
part item numbers 

1 sys\stb_parameter.dat 157 

Tolerance for identical part search 0.5 sys\stb_parameter.dat 184 

    

3-D  Dimensioning Settings    

Dimension line termination Slash sys\dimensioning_settings.x
ml 

 

Decimal places for linear dimensions 0 sys\dimensioning_settings.x
ml 

 

Decimal places for angular 
dimensions  

1 sys\dimensioning_settings.x
ml 

 

Height of dimension figure 2.5 sys\dimensioning_settings.x
ml 

 

Height of dimension texts 2.5 sys\dimensioning_settings.x
ml 
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» Copy HELiOS standard masks 
This option should only be activated if you work exclusively on the basis of the ISD 
standard database. Please note that changes you applied to database masks will be 
overwritten. 

» Starter Configuration 
If you want HiCAD to be preset so that the automatic procedures of the novice 
configuration apply, activate this checkbox.  

» Use own templates  
Activate this option if you want to use your own configurations. Then select the 
relevant configuration file.  

 

2.7 Installing the HiCAD Viewer 
The HiCAD Viewer enables you to view drawings in HiCAD format (*.sza, *.szx) and 
output these drawings (in non-scale representation). This viewer is free of charge and 
may be provided free, without changing the scope of delivery.  
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2.8 Installing the HELiOS Database Creator 
The HELiOS PDM modules (Document management, Part Management, Workflow etc.) 
are based on a relational database. Before you put HELiOS into operation, the Microsoft 
SQL Server database administration system needs to be installed on the server, a 
HELiOS database needs to be imported and a ODBC connection needs tob e set up on 
the clients.  

When you set up a HELiOS database for the first time, the HELiOS Database Creator 
needs to be installed and executed on the database server first. The database and table 
structures will then be created, and filled with data records of the HELiOS standard 
database. 

 

 All information about the correct procedure for the execution of the HELiOS Database 
Creator, as well as the previous and subsequent steps required for the setting up of a 
database server can be found in the user guide for the installation of the Microsoft SQL 
Server Version 2012. You can find this document in the ISD Wiki at Product Know-how > 
Documentation > HELiOS. 

 

To install the HELiOS Database Creator, click the corresponding button in the selection 
mask. The start mask of the setup wizard will be displayed.  
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Click Next to start the installation. 

 

 

Specify an installation directory for the HELiOS Database Creator, and click Next.  



Installation 

   53 

 

 

 

Click Install to start the installation.  

 
 



Installation 

 54 UNLIMITED PERFORMANCE 

 

Click Finish to complete the installation of the HELiOS Database Creator. If desired, you 
can now install further components via the selection mask. 

 

 Extensive information on the installation of the SQL Servers, the operation of the HELiOS 
Database Creator tool and the settting up of the ODBC connection on the clients can be found in the 
Wiki at Product Know-how > Documentation > HELiOS. 
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3 Procedure for Silent Installations 
The silent installation can, for example, be configured for HiCAD, for HELiOS 
Standalone or for the HiCAD Spooler. The procedure is always the same. 

3.1 Installation Settings 
To configure the installation options, start the installation setup.exe as usual and make 
the required settings. 

In the last dialogue of the installation, click on Extended Settings. 

 

Here you can configure in particular the settings for the User Configuration and the 
Catalogs in such a way that user interactions will no longer be required. 

» Execute parameter configuration: Via ISD standard template,  

» Execute CatalogueMaker/CatalogueUpdate: Deactivate Interactive button. 
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Clicking Save creates a setup.ini file containing the desired settings. This file will be 
loaded automatically if it is located in the same directory as the Windows Installer 
package HiCAD.msi. Alternatively you can specify a file via the command line:  

setup.exe  SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

or 

msiexec  /i  HiCAD.msi SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

In this case the starting will not be ‚silent‛, i.e. the installation dialogues wil appear, but 
with the default values of the .ini file. 

The option /l*v "<Log-Datei>" creates a log file of the installation which can be used for 
the diagnosis of installation problems.  

 

 

3.2 Redistributables 
Before distributing the installation you need to install the required redistributables on 
the target systems in order to circumvent the Microsoft-EULAs.  

Examples:  

vcredist.exe /passive 
 
dotNetFx40_Full_x86_x64.exe /passive 

The respective command line options of the individual Redistributable Installer can be 
called via the command line option /?.  

If required, the .msu files of the Windows Installer 4.5 can be installed with the 
Windows Package Manager pkgmgr.exe (http://support.microsoft.com/kb/934307/de). 

 

 You need to install the redistributables that are located on the DVD at Program32 or 
Program64 (except for the setup.exe and the language-specific folders such as de-de). 

 

http://support.microsoft.com/kb/934307/de
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3.3 Starting the Installation in the Silent Mode 
The installation can only be set to the silent mode via the command line: 

setup.exe  SETTINGS="<Ini-Datei>" /passive /l*v "<Log-Datei>" 

or 

msiexec.exe  /i HiCAD.msi /qb!- /SETTINGS="<Ini-Datei>" /l*v "<Log-Datei>" 

As neither dialogues nor error messages are displayed, /l*v "<Log-Datei>" creates a log 
file of the installation which can be used for the diagnosis of installation problems. 

Information on further command line options can be obtained via the command line, by 
means of the command msiexec /? , and via the Internet at 

http://technet.microsoft.com/de-de/library/ 
cc759262%28WS.10%29.aspx#BKMK_SetUI 
http://msdn.microsoft.com/en-us/library/windows/desktop/ 
aa372024%28v=vs.85%29.aspx 

 

3.4 Example of a Batch Installation incl. Redistributables and 
Log 

@set SOURCE=\\entw042\Setups\HiCAD 1800 
 
"%SOURCE%\vcredist_x86_10.0.40219\vcredist_x86.exe" /passive /norestart 
@if errorlevel 1 echo Fehler bei Visual C++ Runtime Installation && goto error 
"%SOURCE%\DotNetFX40\dotNetFx40_Full_x86_x64.exe" /passive /norestart 
@if errorlevel 1 echo Fehler bei .NET Installation && goto error 
 
msiexec.exe /qb!- /i "%SOURCE%\de-de\HiCAD.msi" /l*v 
"%SOURCE%\logs\%COMPUTERNAME%_HiCADInstallLog.txt" 
SETTINGS="%SOURCE%\Config\setup.ini" 
@if errorlevel 1 echo Fehler bei HiCAD Installation && goto error 
@exit 
 
:error 
@echo Installationsfehler %errorlevel% 
@net helpmsg %errorlevel% 
@pause 

http://technet.microsoft.com/de-de/library/%20cc759262%28WS.10%29.aspx#BKMK_SetUI
http://technet.microsoft.com/de-de/library/%20cc759262%28WS.10%29.aspx#BKMK_SetUI
http://msdn.microsoft.com/en-us/library/windows/desktop/%20aa372024%28v=vs.85%29.aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/%20aa372024%28v=vs.85%29.aspx
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4 Important Notes on Configuration Management 
As of Version 1700, HiCAD enables a central configuration management with the 
Configuration Editor. This tool allows the creation of customer-specific configurations 
for a wide range of tasks, such as dimensoning, annotation, workshop drawing creation, 
fitting of vertical ladders etc. Once adjusted to company-specific requirements, these 
configurations can directly be used in HiCAD, without having to specify any further 
settings. The aim of our further developments is a gradual transfer of the previously 
used system files with their adjustable parameter settings into the Configuration Editor, 
thus enabling a central and safe configuration management. 

This transfer has already been realised for the following files:  

» ALGPAR.DAT (ab 1800.0)BEMPAR.DAT (as of 1800.0) 

» DIMENSIONING_SETTINGS.XML (as of 1800.0) 

» KRPGEN.DAT (as of 1801.0) 

» MASPAR.DAT (as of 1801.0) 

» FITTABLE_SETTINGS.XML (as of 1801.0) 

The settings from these files have been integrated into the Configuration Management. 
In the Online Help for the Configuration Management you will find the document 
Schluesselnamen.pdf, which shows you where you can retrieve the entries from the 
DAT files in the Configuration Editor.  

In addition, the Online Help provides a description of various scenarios for the utilisation 
of the tool.  An extensive description of the Configuration Management (Performance – 
Functions – Scenarios)  is provided in the document ISD-Configuration.pdf. You can 
find this document 

» in the ISD Wiki at Product Know-how > Whitepaper 

» in the Docu\hicad sub-directory of your HiCAD installation sowie 

» on the start page of the Online Help at www.help.isdgroup.com 

http://www.help.isdgroup.com/
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4.1 The Configuration Management after Updates 
When performing an update from HiCAD 2011 or HiCAD 2012, your settings from the 
existing configuration file HICAD.CFGDB of your previous HiCAD version will be 
transferred to the Configuration Management of HiCAD 2013, namely into the 
Administrator profile. 

When the update is performed, only the values predefined by the ISD, i.e. the ‚factory 
settings‛, will be changed. All other (administrator or user) settings will be preserved.  

If you use a central configuration database on a server, it will be automatically detected 
by the update program by means of the aforementioned Registry entry, and will be 
updated. For an update of several workstations, one single update will be sufficient; a 
multiple update will, however, not do any harm either (as an already updated setting will 
not be updated again).  

 

4.2 The Configuration Management after New Installations  
If you perform a (new) installation of HiCAD 2013, the settings predefined by the ISD 
will be initially used in the Administrator profile of the Configuration Management. If you 
want to transfer your individual settings in the file HICAD.CFGDB from HiCAD 2011 or 
HiCAD 2012 to the Configuration Management of HiCAD 2013, use the program 
CfgDbTool.exe in the HiCAD EXE sub-directory for this. 

Furthermore, you are enabled to transfer settings from old DAT and XML files which are 
now managed in the Configuration Editor, to the configuration database of the version 
2013. 

» Start the CfgDbTool.exe  from the HiCAD / exe sub-directory.  



Important Notes on Configuration Management 

   61 

 

Use the Update tab of the CfgDBTool you tab to transfer the settings of your previous 
configuration file (.CFDB) to the configuration file of version 2013.  

 

Installed database The configuration database to be updated, i.e. (the 
configuration database of your previous HiCAD version 
HiCAD-Version 2011/2012). 

Update source The configuration database of the new version; the 
configuration database with the current ISD settings can 
be found in the folder: [HiCAD installation 
directory]\Configuration.  

Update target The result of the update. If you enter the same file here as 
in the Installed database, a backup of the previous 
configuration database will be created. You cannot enter 
the same database here that you entered in the Update 
source field.  

» Select the directories. 

» Click the Update button to start the process. 
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Use the Migrate tab to transfer your individual settings from old DAT and XML files 
which are now managed in the Configuration Editor, to the configuration database of the 
version 2013. 

The setting files with their adjustments need to be copied to the HiCAD SYS 
subdirectory of the new HiCAD version for this purpose.  

Start the CfgDbTool.exe  from the HiCAD / exe sub-directory and activate the Migrate 
tab.  

 

 

HiCADS root folder Here you enter the directory where your old DAT and XML files 
etc. are located. Please make sure that the old files have the 
same name and are located in the same directory structure as in 
a HiCAD standard installation. 

Database Here you specify the database to which the data are to be 
transferred.  

» Select the directories. 

» Click the Migrate button to start the process. 
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5 Important Technical Information 
5.1 Data Compatibility HiCAD/HELiOS 2013 (Version 180X) 
Please note that no changes are made to the HiCAD data format and the HELiOS 
standard database within a major release. This means that all patches and service 
packs of a version (e.g. 1800.x, 180X.x) will use the same data format, and no HELiOS 
update will be required. 

  When updating from previous versions to Version 180X, please note the following: 

 

Update from version HELiOS-Update Changed HiCAD data format 

1212.4 or older X  X 

15xx.(x) or older X X 

1601.(x) X X 

170X X X 

 

» Notes: 

 If a HELiOS update is necessary, older HiCAD, respectively HELiOS versions have 
no access to the database any more. All workplaces need to be converted at the 
same time. 

 If the HiCAD data format has been changed, drawings and parts cannot be loaded 
with the older version if they were saved with the new version. 

 After updating HELiOS, the database needs to be additionally converted from ANSI 
to UNICODE character set (for more information see the separate documentation). 
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5.2 Important Notes on Updates 

5.2.1 Perform Installation 
The installation of version 2013 can be carried out by a technician of the ISD or by the 
customer. In this context, please note the following recommendations by the ISD: 

» HiCAD without HELiOS 

 Update of version 2010 to version 2013: Can be carried out by experienced users 
with sufficient basics.  

 Update of version 2008 (or older) to version 2013: An installation by the ISD is 
recommended. 

» HiCAD with HELiOS 

 Update of version 2010 to version 2013: An installation by the ISD is 
recommended. 

 Update of version 2008 (or older) to version 2013: An installation by the ISD is 
recommended. The update installation includes a data conversion to UNICODE 
format. 

» 3rd party CAD with HELiOS 

 Update of version 2010 (or older) to version 2013: An installation by the ISD is 
recommended. 

 

5.2.2 Licensing 
Version 2013 can be obtained either on an installation medium (DVD), or via download 
from the ISD Homepage.  

As of HiCAD/HELiOS version 2010 the activation takes place via a software license. The 
activation is no longer linked to a dongle, but directly to the hardware of a server or an 
individual workstation. 

If you use a Server License, you need to update the License Server Software and the 
License Management Tools; if you use Local Licenses, you need to install the new 
version.  
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Normally, licenses for older HiCAD/HELiOS versions must be revoked first.  

After confirmation of the revocation you will receive one or several Entitlement IDs 
enabling you, in combination with your E-Mail address and your Password, to activate 
the new licenses. (see 6.3) 

Licenses can be deactivated at any time, without having to contact the ISD Group, via 
the License Activator in the ISD License Manager, i.e. they can be temporarily stored on 
the Server of the ISD. For this you require your Entitlement ID, your E-mail address and 
your Password. The activation can then be performed on any other computer, i.e. the 
licenses can be transferred to this computer. For Server Licenses this procedure can 
only be performed for the entire license pool.  

 After updating HiCAD and HELiOS (Version 2008 or older) to Version 2013, you 
must return your workstation dongle to the ISD. You can then no longer use any older 
HiCAD/HELiOS versions.  

 

5.2.3 CatalogueMaker 
The CatalogueMaker is called automatically by the installation program in case of a new 
installation.  

It specifies which standard series is to be shown in the standard part catalogues (at the 
moment standard series are available for DIN, ISO, EN, ANSI and JIS). The selection of 
the standards in the CatalogueMaker influences the display of the standard parts only, 
not their availability. This will still be controlled by the license selection in the 
configuration menu. 

The existing configuration will be taken over automatically in case of an update; the 
CatalogueMaker will not be started automatically. If you want to add standards to the 
catalogues, the program can be called in the ISD program group in the start menu via 
‚Administration". 

 

5.2.4 Material Manager  
The Material Manager (materialmanager.exe) that enables a taking over of materials 
from Catalogue Editor to HELiOS needs to have the same database schema as HELiOS. 
Therefore the Material Manager will also be updated.  
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5.2.5 Computer / User Configuration 
A computer configuration for HiCAD settings can be activated in case of a new 
installation, respectively update. 

The ‚Workstation Parameter Configurator‛ can be started for a subsequent call by the 
Administrative Tools of the ISD program group. 

Depending on the selection in this window, the settings, saved in the corresponding 
CSV-file, will be configured. The default CSV-files can be found in the templates 
directory of the HiCAD installation. 

Important: 

» The settings files in the templates-directory will be overwritten without further queries 
in case of an update. 

» Company-specific CSV files can be filed in the sys-directory of the HiCAD installation; 
they can then be selected via the drop-down-list of the computer configuration. 

» Activate the HiCAD / HELiOS standard solution only when using the database 
supplied with HiCAD / HELiOS neXt 2007 or later. 

» When updating, the copying of standard masks must be activated only if no 
customized masks or BOMs are used. 

 

5.2.6 *.KRP to *.KRA Conversion 
(only relevant for updates from HiCAD neXt 2005 or older) 

As of HiCAD neXt 2006, the HiCAD 3-D parts (*.KRP and related files) are combined in 
one archive (*.KRA). 

Before making the necessary conversion, you should save the directories, where the 
HiCAD 3-D parts have been saved (these are usually the paths given for the file groups 
C:, L: and M: in the FILEGRUP.DAT file; please check further adaptations). 

You need the SZN-SZA-Konvertierung.exe program once for the conversion. The 
program can be found in the \isdtools directory on the HiCAD installation CD. 
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Copy the UpdateTools directory (with all files and sub directories) to the computer you 
want to use for the conversion. 

Start the SZN-SZA-Konvertierung.exe from this directory. The following window will be 
shown: 

 

» Enter the UpdateTools directory as the directory of the HiCAD neXt installation. 

» Select the directory of the KRP files and the destination directory for the KRA files 
(these directories may be identical). 

» Activate the Convert all KRP files in given directory option and decide if KRPs, 
which are no longer used, are to be deleted in one step and if subdirectories are to 
be included in the conversion. 

The conversion of the given directory will be started after selecting the Execute button. 

If you need to convert KRP files into different directories, the previous steps need to be 
repeated accordingly. 
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 We recommend the deletion of the KRP files, in particular when working without 
HELiOS, as they can still be loaded in HiCAD and can result in different states of KRP and 
KRA files. 

When using HELiOS functions, only KRA files are loaded, the change from KRP to KRA in the 
database is automatic during the database update with the help of the 
Helios2toHeliosNext.exe program. 

 

5.2.7 Important Notes on the Modules ‚Plant Engineering‛ and ‚Pipeline 
Isometry‛ 

HiCAD 2012 introduced a new file format for Plant Engineering parts. 

If you have used the modules ‚3-D Plant Engineering‛ and ‚Pipeline Isometry‛ in the 
previous HiCAD version, please note the following:  

It is assumed that the previous, old HiCAD version was installed at Y:\hicad , and the 
new version will also be located at Y:\hicad after the update (Y indicates the drive). 

11..  Before installing the Update, check in the old version the entry at position 6: in the 
FILEGRUP.DAT file that is located in the in the HiCAD EXE subdirectory. This entry 
determines the part directory for HiCAD Plant Engineering.  

Example 1: 

6:\\MyServer\hicad\PlantParts (or 6:\\MyServer\hicad\anlbautl) 

Here, a network path is specified for the Plant Engineering part directory, i.e. the 
part directory is located on a different computer. Create a backup copy of this 
directory.  

Example 2: 

6:X:\hicad\PlantParts  (oder 6:X:\hicad\anlbautl) 

X indicates the drive.   

Create a backup copy of this directory. 

Only if X is equal to Y, rename the part directory to Y:\hicad\MyPlantParts. 
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If a directoryY:\hicad\PlantParts still exists in your old HiCAD version, rename it to 
Y:\hicad\PlantPartsOld. 

 

22..  Now perform the HiCAD Update Installation. Please do not start HiCAD yet.  

 

33..  After the HiCAD Update Installation:  

After creating a directory Y:\hicad\MyPlantParts  as described in Example 2, now 
rename the directory Y:\hicad\PlantParts to Y:\hicad\PlantPartsOriginal , and then 
rename Y:\hicad\MyPlantParts to Y:\hicad\PlantParts (or Y:\hicad\anlbautl) 

In \hicad\exe\filegrup.dat at position 6: re-enter the directory path that was entered 
there in the old version. Check whether the following subdirectories exist in the part 
directory that has been entered there:  

CatSearch 

Symbols 

If one (or both) of these subdirectories is missing in the part directory (but only if this 
is actually the case!), copy it (them) from C:\hicad\PlantPartsOriginal to the part 
directory. 

If CatSearch already existed, copy the file CatDbAttMapping.txt from the directory 
C:\hicad\PlantPartsOriginal\CatSearch to the subdirectory CatSearch of the part 
directory and overwrite the already existing file. 

Copy the subdirectories 

PartInspect 

TemplateMacro 

VariantStruct 

from C:\hicad\PlantPartsOriginal to the part directory and overwrite the already 
existing files. 

 

44..  Start HiCAD and perform the update of the Plant Engineering part data as soon as 
you are prompted to do so by a corresponding dialogue.   



Important Technical Information 

 70 UNLIMITED PERFORMANCE 

5.2.7.1 Automatic update of part files (and database) 

If you have already created your own Plant Engineering parts with an older HiCAD 
version, you will, of course, want to re-use these parts in newer HiCAD versions. First 
make sure that you have entered the correct current directory path to your Plant 
Engineering part files at item 6: in \hicad\exe\FILEGRUP.DAT. 

Then start HiCAD. When you now try to load a drawing, or create a new drawing, the 
following window will be displayed:  

 

If you do not want to use the Plant Engineering modules right now, click Update later, 
and continue to work with HiCAD as usual. The window will not reappear until the next 
HiCAD start. 

If you want to use HiCAD Plant Engineering, click Update now. This will start the tool for 
the update of your part data. If you use the HELiOS database as part data source, the 
Login window appears (otherwise, you will be directly taken to the next window): 
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As you also want to update the database automatically, it is mandatory that you have 
the necessary write access (rights for the Administration function). 

When you click Login, the following window appears:  

 

 

Click Start. The update of the part data begins. Depending on the number of existing 
part files, this process will take 10 – 20 minutes; this time can be significantly longer if 
the data are transferred via a network. The updating was successful if an archive file 
could be generated for all parts with part master data (or catalogue entry, respectively, 
in case of the Catalogue as part data source). For all other parts, too, an archive file will 
be created if possible. If the updating was not successful, an error log will be displayed, 
indicating for each part whether or not an archive file could be successfully generated.  
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If the database is the part data source, the following changes will be made to the 
database, in addition to the update of the files: 

» In the document masters of the Plant Engineering parts, the file names will be 
modified, i.e. the extension .vad will be replaced with .vaa, and the extension .kra will 
be replaced with .paa. 

» The superordinate classes used for part classification obtain an ID, the so-called 
‚industry ID‛. (10001 for the class Plant Engineering, and 10002 for the class Air 
ducts). 

» The link definitions required for pipeline isometry will be entered (pipeline isometry 
and pipeline layout plan).  

» If a Vault Server exists and is activated, the archive files will be moved to the Vault 
Server. The files can then no longer be accessed via the Windows file system.  

After the update, click End and re-start HiCAD. Your parts are now available in HiCAD 
Plant Engineering. 

 

5.2.7.2 Auto-synchronisation of the database 

If you have not used an earlier HiCAD version and install HiCAD for the first time, the 
part files will directly be available in the new archive file format. It is however possible 
that the installed HELiOS database still needs to be adjusted accordingly. 

If this is the case, the following window will be displayed when you try to load a drawing, 
or create a new drawing:  
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If you are currently not working with the HiCAD Plant Engineering modules, click 
Update later, and continue to work with HiCAD as usual. This window will not reappear 
until the next start of HiCAD.  

If you want to use HiCAD Plant Engineering, click Update now. This will start the tool for 
the update of your database.  

First, the following Login window will appear: 

 

It is mandatory that you also obtain the necessary write access when you log in (rights 
for the Administration function). 

After you have logged in, the following window appears:  
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Click Start. The update of the database begins. Depending on the number of existing 
part files, this process will take 15 – 30 seconds; this time can be significantly longer if 
the data are transferred via a network.  

The following changes will be performed in the database:  

» In the document masters of the Plant Engineering parts, the file names will be 
modified, i.e. the extension .vad will be replaced with .vaa, and the extension .kra will 
be replaced with .paa. 

» The superordinate classes used for part classification obtain an ID, the so-called 
‚industry ID‛. (10001 for the class Plant Engineering, and 10002 for the class Air 
ducts). 

» The link definitions required for pipeline isometry will be entered (pipeline isometry 
and pipeline layout plan).  

» If a Vault Server exists and is activated, the archive files of the parts will be moved to 
the Vault Server. The files can then no longer be accessed via the Windows file 
system.  

After the update, click End and re-start HiCAD. Your parts are now available in HiCAD 
Plant Engineering. 
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5.2.8 Update Training 
ISD now offers a 2-day Update Training for new versions. Further information on 
training dates can be found on the attached form or our website: www.isdgroup.com / 
Support / Training. 

http://www.isdgroup.com/
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6 Licensing  
HiCAD/HELiOS can be activated via three license types:  

» Network licenses 

» Standalone licenses (local licenses) 

» Commuter licenses 

 In the HiCAD directory DOCU you can find an Online Help for the Licence Manager. 
You start the Help by calling the LICENSEMANAGER.HTML file in the folder 
Docu\tools\Licensemanager.  
 

 In the ISD Wiki you can find the PDF document Use Case: Checkout Licenses at Product Know-
how > Whitepaper. 

 

 

6.1 General Information about Licensing 

6.1.1 Local (Workstation-Specific) Licensing 
If you choose local licensing, the activation will be directly locked to the hardware of the 
workstation on which your HiCAD and HELiOS Desktop program is installed.  

The ISD will send you an E-mail containing the Entitlement ID for local licenses 
(standalone).  This ID will be required for the activation and deactivation of the licenses 
and software modules. Please keep the Entitlement ID! Without this ID you cannot 
activate or deactivate any licenses! In case of a defect, no reconstruction of licenses will 
be possible without the Entitlement ID!  After installing HiCAD/HELiOS, you activate the 
licenses by means of the License Activator in the ISD License Manager. 

 

https://wiki.isdgroup.com/display/wpaper/Whitepaper
https://wiki.isdgroup.com/display/wpaper/Whitepaper
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6.1.2 Network (Server-Controlled) Licensing 
If you choose network (server-controlled) licensing, the license will be directly locked to 
the hardware of the server that centrally manages the HiCAD/HELiOS licenses. These 
licenses can be used on any workstation in your network that is connected to this 
server.  

The ISD will send you an E-mail containing the Entitlement ID. If you have several 
network servers, e.g. at several locations, you will receive one Entitlement ID for each 
network server. This ID will be required for the activation and deactivation of the 
licenses and software modules. Please keep the Entitlement ID! Without this ID you 
cannot activate or deactivate any licenses! In case of a defect, no reconstruction of 
licenses will be possible without the Entitlement ID!  You activate/deactivate the network 
licenses by means of the License Activator in the ISD License Manager.  

Individual licenses can be checked out from the server and locked to a workstation 
within or outside the network (so-called ‚commuter licenses‛). This enables you to 
continue working at a different location, without being connected to the license server 
(unless your HiCAD/HELiOS installation requires a connection to a database server).  
For this purpose you define a specific period during which you want the license to be 
available on a selected workstation. For this period, this license will be blocked on the 
license server. After expiry of this period, the license will be made available on the 
license server again. It is also possible to manually return this license to the server 
before expiry of the defined period, if the workstation is connected to the server. 
Licenses for one workstation can be checked out for at least one day, with the counting 
beginning at 1:00 AM on the day following the checkout date.   

If you want to replace/exchange your license server, you need to deactivate all licenses 
first. 

 

 A static IP address is required for correct operation of the license server! 
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6.1.3 Practical Examples of Network Licensing 

» Let us assume that three licenses have been activated on your server. Monday 
morning (11.00 am) you suddenly need to see a customer for design tasks, and you 
know that you will still be on-site at the customer’s facility on Tuesday. You therefore 
check out a license for 24 hours on 11.00 am. This means that you can use this 
license until Tuesday night, 11.59 pm, from your mobile workplace. After expiration 
of this period, the license is automatically made available again on the server. If you 
manage to finish your work on Tuesday at midday, you can go back to your office 
and return the license to the server somewhat earlier. 

» Similar situation as the one described above, with the difference that you are not in 
your office on Monday, 11.00 am. In such cases you can generate a hardware ID, 
enabling your colleagues in the office to check out a license for you. This license is 
sent to you by E-mail and can then be activated. In contrast to the previous example, 
this license is exclusively available to you for a fixed period of time and cannot be 
returned to the server before expiration of this period.  

If you activate a license while the WLAN card is switched on, this license will only be 
valid and visible when the WLAN card is switched on. If, however, the license is 
activated while the WLAN card is switched off, the license will always be valid, no matter 
whether the WLAN card is switched on or off.  

 The PDF document Use case: Check out licenses provides further information on 
this topic. The document can be found in the ISD Wiki at Product Know-how > 
Whitepaper. 

 In the ISD Wiki at Product Know-how > Whitepaper you can find the PDF 
document Use case: Checkout Licenses. 

 

6.2 Network Licenses 
To be able to use network licenses, a License Server needs to be installed on a 
computer without HiCAD/HELiOS.  

The license server enforces and manages licensing in multi-user environment. It keeps 
track of all the licenses and handles requests from network users who want to run a 

https://wiki.isdgroup.com/display/wpaper/Whitepaper
https://wiki.isdgroup.com/display/wpaper/Whitepaper
https://wiki.isdgroup.com/display/wpaper/Whitepaper
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HiCAD/HELiOS application, granting authorization to the requesters, or denying 
requests if all licenses are in use.  

The license server must not be installed on the same computer on which an ISD 
software product (HiCAD, HELiOS) is installed, as both product share system data 
concerning the licensing information. Formerly, such parallel installations of license 
servers and ISD products were performed in cases where a customer occasionally 
wanted to transfer the license to another computer (Remote Commuter License). As of 
Version 1700 such scenarios can be realised in a much more convenient manner with a 
new licensing procedure.  

 

 Please note:  

 As of Version 1700, parallel installations of license servers and ISD products (i.e. on 
the same computer) are no longer covered by the warranty. The ISD group advises 
you strongly not to perform such installations.   

 A static IP address is required for a correct operation of the License Server! 
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6.2.1 Server Installation 
The SafeNet License Server is installed from the HiCAD DVD. Start Windows. If 
Windows is already open, close all other applications. Insert the DVD in the DVD drive. 
The installation wizard will be started automatically. In the installation wizard, click the 
Standard Edition button, which opens a mask with various selection options for software 
components.   

 

 If you want to perform a HiCAD update to Version 2013 and use a license server (i.e. 
work with network licenses), you require Version 8.5.0.1400 of the SafeNet License Server. 
If you have installed an older version, you need to uninstall it before re-installing the 
SafeNet License Server. 

 

 

 

Click the SafeNet License Server button to start the installation.  
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After successful installation you will find the Server (Sentinel RMS License Manager) 
under Services. From here you can also start and end the License Server.  
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6.2.2 Client Configuration 
To ensure that the HiCAD/HELiOS Client finds the correct License Server, an 
environment variable LSFORCEHOST should be set on each Client using network 
licenses. The value HOSTNAME, respectively the IP address of the License Server is 
assigned to the variable. 

 

6.3 Licensing via Entitlement ID (License Activator) 
Thanks to the enhanced ISD License Manager 2.0 the communication between the 
customer and the ISD could be facilitated significantly.  

 

6.3.1 AutoRequest Licenses  
When acquiring a HiCAD/HELiOS license, you will obtain one Entitlement ID for local 
licenses (Standalone) and another one for network licenses (Network). If you have 
several network servers, e.g. at different locations, you will obtain one Entitlement ID for 
each network server. These numbers will be required for the activation and deactivation 
of the licenses and the software modules.   
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 Please keep the Entitlement ID! Without this number you cannot activate or 
deactivate licenses. In case of a system crash a reconstruction of the licenses cannot take 
place without the Entitlement ID! 

After installing HiCAD/HELiOS you can find the program in the Windows Start menu at 
ISD Software und Systeme > Administration. Please note that for the execution of 
some functions, administrator rights are required.  

The range of functions of the ISD License Manager depends on the activation of the 
License Administration Tools option. The information about this setting is entered in the 
Registry and can also be changed there subsequently if desired (please contact the 
Hotline).   
 

 To activate/deactivate Network Licenses, always start the ISD License Manager via 
the Windows Start menu: Select Start > All programs > ISD Software und Systeme GmbH > 
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Administration. To avoid errors when activating/deactivating licenses, perform an update of 
the new ISD License Manager and/or the License Administration Tools beforehand. 

 

Activate the License Activator tab and enter the Entitlement ID, your E-mail address 
and your Password. New customers obtain their password from the ISD Hotline. With 
this password you can also access the Download Area.  

 

After entering the data, click Login. The ISD License Manager 2.0 connects to the ISD 
License Server and the acquired licenses will be displayed.  

This process may take several minutes. You can then activate the licenses. 
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6.3.2 Activate Licenses 
After successful login, the number of available licenses and the number of acquired 
licenses are indicated next to each module. Select the modules to be activated and click 
Activate to start the activation.  

For Server Licenses the modules are already pre-selected! 

 

After successful activation a message showing you that all licenses have been 
successfully activated will be displayed:  

 

You can then log out and start working with the HiCAD/HELiOS modules. 

In addition, you will receive an E-mail informing you about the deactivated modules.  
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For Network Licenses, all modules will always be activated or deactivated (for further 
information about the operation of the License Manager, please read the Online Help for 
the License Manager. 

 

6.3.3 Deactivate Licenses  
A deactivation of licenses for modules will be required in the following situations:  

» Exchange of hardware or changing of hard disk partitioning 

» Update of the operating system (e.g. from Windows XP to Windows 7)  
For updates within one version no deactivation will be required. 

» Transfer of local modules from one workstation to another 

» Acquisition of further modules, or return of hired licenses 

» Switch from local licenses to network licenses 

Please note the following: All workstations with modules having the same Entitlement ID 
need to be deactivated completely before a redistribution of the module licenses can 
take place. 

After starting the ISD License Manager 2.0 the activated modules will be highlighted in a 
different colour. Click the Deactivate button to revoke the activation of the modules.  
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A selection is not possible, as you need to deactivate all modules, no matter whether 
local licenses or network licenses.  

 The deactivation must not be disrupted, e.g. by a logout or the closing of ISD License Manager 
2.0! 
 

After successful deactivation the following message will be displayed:  

 

 

6.3.4 Trial Licenses  
If you select Display trial licenses after logging in, you will be also shown, besides all 
trial licenses with a limited period of validity, all purchasable licenses which are not 
simultaneously available as trail licenses.  
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6.3.5 Reconstruction of Licenses  
As all licenses are stored on the ISD Server, you can, in case of an interrupted 
connection or an accidental deletion of licenses, restore all licenses by logging in with 
your Entitlement ID. The restoring will only function if the hardware was not changed 
(see 4.2.3.3 Deactivate Licenses). 

 

6.3.6 Notes Regarding the Use of Mobile Computers (Laptops) 
If you use a computer with WLAN card, Please make sure that the WLAN card is either 
always switched on, or always switched off.  
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6.3.7 Floating Licenses 
If you have acquired a HiCAD Extension Module with the property Floating-able at 
runtime, you can activate/deactivate them during the current HiCAD session. The 
HiCAD Selection dialogue window will be displayed. 

 

If one Extension Module is (de)activated, the Extension Modules that are prerequisites 
for this module will also be (de)activated (if they are also floating-able at runtime).  
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6.4 Commuter Licenses 
Commuter licenses enable you to use network licenses even if the workstation is not 
connected to the Server. There are two ways of receiving commuter licenses: 

» Via direct checkout from the License Server 

» Via checkout from License Server, without network connection 

 

6.4.1 Direct Checkout from License Server 
Start the ISD License Manager application (while a connection to the Server still exists). 
Switch to the Commuter License tab.  

 

If you have set the system environment variable LSFORCEHOST, the entered License 
Server is displayed at start-up as pre-selection. Use the Search network button to 
automatically search for License Servers.  
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Expand the tree structure of the found Server by a click on the ‚+‛-sign. The result 
looks as follows:  

 

Select the required licenses by activating the corresponding checkboxes on the left 
hand side. On the right hand side, information on the selected license is displayed.  

In the Commuter license: Validity in days field, you enter the number of days that you 
want the commuter licenses to remain checked out from the Server. The maximum 
number of days is 60. By default (or if a ‚0‛ is entered), the value is set to 1.  

 

 For reasons of safety you should check out the licenses only for the required period! 
If a commuter license is lost, e.g. because of theft or a defect of the client computer, the 
license on the Server cannot be used any more before expiry of this date! 
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After entering the expiry date for the commuter licenses, activate the Update licenses 
button. 
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Commuter licenses are checked out from the Server. 

 

 

All selected licenses are now checked out from the Server and you possess all rights on 
your computer for the specified validity period for the commuter licenses. This means 
that you are enabled to work network-independent. The checked out licenses are no 
longer available to the other computers on the net.  

You can however also return the commuter licenses before their expiry date. To do this, 
you need to connect to the Server, deactivate the checkboxes on the left and click the 
Update licenses button. All licenses are now made available on the Server and locked 
on your computer, i.e. you can now only use HiCAD/HELiOS if there is a connection to 
the License Server. The licenses made available again can now also be used from other 
workstations. 
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6.4.2 Checkout from License Server, Without Network Connection 
Commuter licenses can also be drawn from the License Server without an existing 
network connection.  

 

 Please note that administrator rights are required.  
Commuter licenses checked out in this way cannot be returned to the License Server! This 
means that the commuter licenses that have been checked out from the Server are only 
(automatically) made available again after their expiry date. 

 

Several steps are required for this, by the administrator having a network connection to 
the License Server, as well as by the Client having no network connection to the License 
Server.  

The Client starts the ISD License Manager tool, switches to the Remote Locking Code 
tab and sends the generated character set to the administrator (via E-mail or over the 
phone). 
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The administrator starts the ISD License Manager and switches to the Commuter 
License tab. The License Server is selected, and the required licenses (modules) are 
activated in the left window. To checkout a remote commuter license the administrator 
now needs to activate the Check out authorisation for remote computer checkbox. 

 

A click on the Update licenses button opens a new dialogue window, in which the 
administrator enters the character set received from the Client.  
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After selecting OK, another dialogue opens, in which you enter the target path and the 
file name for the licenses to be swapped out.  

 

Select OK to check out the commuter licenses from the License Server and swap them 
out to a file, e.g. RemoteLicCode.lic. 



Licensing 

   101 

 

The successful checkout will be confirmed. The administrator then sends the file, 
RemoteLicCode.lic, to the Client.  

After receiving the file with the commuter licenses, the Client starts the ISD License 
Manager again and activates the Install Remote Authorisation Code tab. Here the 
received commuter licenses can be installed directly via file selection or via copying of 
the file contents.  

 

Click the Install... button to install the commuter licenses on the Client.  
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After successful installation, switch to the License Info tab. Press the F5 (Update) key 
on your keyboard. You are now informed which licenses are installed locally on the 
computer.  

 

 

6.5 License Configuration 
Some cases may require the use of only certain specific licences on a computer. 
Example: On the License Server, HiCAD creator and HiCAD solution licences are 
available. On one Client, HiCAD is to be started with a HiCAD creator license, on 
another Client, HiCAD is to be started with a HiCAD solution licence. If the selected 
license is no longer available, an application start is no longer possible.  

 

 If there are several basic modules in a standalone (workstation) license (to which 
also the Commuter Licenses belong), it is mandatory to make a pre-configuration and save 
it as workstation configuration. If no pre-configuration is possible, the HiCAD/HELiOS 
configuration tab will be displayed before the start of HiCAD/HELiOS. If the selected 
configuration does not match the available licenses, a warning message will be issued, with 
a list of available licenses. After this, the configuration selection will be displayed again. 
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6.5.1 License Configuration HiCAD 

 

 

On the HiCAD Configuration tab of the ISD License Manager tool you have the option 
to save a workstation or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of 
this computer. When HiCAD is started, the selection window is no longer displayed 
(administrator rights are required for this).  

» Save as user configuration: This configuration is only saved for the current user. 
When HiCAD is started, the selection window with the saved configuration is always 
displayed.  

These licence configurations apply to network licenses and standalone (workstation) 
licenses.  
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6.5.2 License Configuration HELiOS 

 

On the HELiOS Configuration tab of the ISD License Manager tool you have the option 
to save a workstation or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of 
this computer. When HELIOS is started, the selection window is no longer displayed 
(administrator rights are required for this).  

» Save as user configuration: This configuration is only saved for the current user. 
When HELiOS is started, the selection window with the saved configuration is always 
displayed.  

These licence configurations apply to network licenses and standalone (workstation) 
licenses.  
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6.6 Important Softlock/Hardlock Information 
When using the softlock/hardlocks as selector for the license file, please note that for 
system-inherent reasons the date must not be reset! Such resetting causes a blocking of 
the softlock/hardlock that can only be revoked by the ISD by means of a re-
programming. In such cases, we would have to charge you the costs of this 
unnecessary additional work. 

A change of the system time is possible, as long as it is not date-comprehensive. 

If you deem such date conversion absolutely necessary, please inform our staff on the 
hotline in good time. 

 

ISD Software und Systeme GmbH 

Phone: 0049 - 231 / 97 93 - 166 

Fax: 0049 - 231 / 97 93 - 101 

Mailto: hotline@isdgroup.de 

 

 IMPORTANT:  If you have a 64Bit version of HiCAD/HELiOS, the hardlock can no longer 
be used as a license file selector due to missing driver support! 
 

6.7 Theft of a Workstation 
The user is responsible for appropriately insuring the HiCAD/HELiOS workstations 
against theft. If desired, we can tell you the reinstatement value of your software. If a 
workstation is stolen, you will need a new license. In such cases, please send us the 
police report of the theft first. We will then provide you with a license for a limited period 
of time, and submit an offer for a new license to you. The ISD will send you the new 
license after clarification of the case with your insurance and receipt of your payment for 
the license fee. 

mailto:hotline@isdgroup.de
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7 HiCAD at a Glance 
HiCAD is a universal CAD system with true 2-D/3-D associativity, innovative functions, 
comprehensive industry solutions and an integrated PDM component. Up-to-date 
working techniques and numerous automatisms help you abridge routine tasks. 
Simulation and analysis tools enable you to detect and prevent possible collisions within 
your product models at early design stages.  

» Performance characteristics:  

 Microsoft Windows standard and GUI based on the Windows ‚Ribbons‛ 
technology 

 Combined working in 2-D and 3-D  

 Assembly-oriented design engineering providing top performance even for very 
large assemblies  

 Transparency and clearness thanks to convenient search functions, filters and 
multiple selection options  

 Extensive symbol and standard part catalogues 

 Simulation and analysis tools  

 Standardisation and automation 

 Direct modelling and parametric design 

 Integrated product data management with HELiOS  

 Data transfer from other systems (CATIA, ME10, STEP, DXF, DWG etc.)  

 BOM-creation, PPS interface, transfer to NC programs  

 Comprehensive industry solutions for Steel/Metal Engineering, Plant Engineering, 
Sheet Metal processing and Plant Engineering 

 Individually extendable due to a modular structure  
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8 First Steps in HiCAD 
8.1 Start HiCAD 
You start HiCAD by:  

» using the Windows task bar (Start) to choose the Programs folder and then clicking 

the HiCAD icon  in the ISD … menu, or   

» by clicking the HiCAD icon  on your desktop.  

Once you have started HiCAD, the input window for License Management is initially 
displayed, followed by the HiCAD Start Centre (provided that it has not been 
deactivated).  

 During the launch of HiCAD it is checked whether the required version of .NET 
Framework is actually installed. If this is not the case, an appropriate error message is 
issued and HiCAD is closed. 

 

8.2 DLL Check  
Due to entries in the Windows-Registry, more and more libraries from third parties (DLL 
file) are integrated when HiCAD is launched, e.g. in order to capture messages or 
outputs to the screen. Some examples are 

» Virus scanners, 

» PDF programs,  

» Programs for the recording of screen activities,  

etc. These files can sometimes cause problems.  
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When you start HiCAD, it will first be checked whether DLL files are assigned to the 
Registry value AppInit in the Registry key  

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 
NT\CurrentVersion\Windows (64Bit) 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Windows 
NT\CurrentVersion\Windows (32Bit) 

If this is the case, the following message will be displayed: 

 

Activate the Suppress message checkbox if you do not want this message to be 
displayed upon future HiCAD starts. Also inform your administrator about the message. 
The message will not reappear until the Registry value changes again, i.e. not until other 
DLLs will be loaded!  

If you want to suppress the message completely, set the Registry value Check for 
AppInit_DLLs in the Registry key  

HKEY_CURRENT_USER\Software\ISD Software und Systeme\HiCAD2013\HiCAD 
2013 

to 0. 

 Be careful when editing the Registry! The entering of incorrect values or the 
deleting of values can destablilize the operating system! 
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8.3 Close HiCAD 
To close HiCAD,  

» click the Close icon  or 

» click the ISD button and select End.  

If any HiCAD drawings are still open at this point, you can to save them.  

 If you activate the Clear temporary directory? checkbox when closing HiCAD, all 
automatically created data backups will be deleted. 
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8.4 The Start Centre 
When you start HiCAD for the first time, the Start Centre is displayed, which has been 
designed to facilitate your first steps of drawing creation.  

 

Please note:  

» Click on the graphic to obtain information about the version number.  

» When you call the Start Centre again, the values that you set last will be displayed as 
default values.  

» The settings you have selected for the Create new drawing start action will even be 
used in HiCAD if you call the New drawing (without DB) function. 
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8.4.1 Create New Drawing 
If you want to create a new drawing, specify whether you want to create a part drawing 
or an assembly drawing by activating the appropriate checkbox.  

» Part drawing (detail drawing)   
In a part drawing (detail drawing) you divide your drawing into main parts and sub-
parts. To define the part structure you use so-called dummy parts which symbolise 
the assembly. You then assign assembly-relevant main parts and sub-parts to these 
dummy parts. Instead of dummy parts you may as well use the special component 
type Assembly.  

» Assembly drawing   
You can define 3-D drawings directly when creating the assembly drawing and - if 
you are working in parallel with HELiOS - enter them into the database. This provides 
significantly more efficiency, particularly for referencing, itemisation and BOM-
creation.  

 

8.4.2 Options 

» Enter drawing into database  
If you are working with HELiOS you can define here whether you want to the new 
drawing to be entered into the database. If you activate this checkbox, HiCAD will 
prompt you to specify the document master data once you exit the Start Centre. If 
not, you will be prompted to enter the name of the drawing file.  
Activate, if desired, the project to which you want to assign the drawing.  

» Scale  
Here you can preset the scale of the drawing.   

» Start mode  
Here, choose the start mode you want to be activated once you exit the Start Centre, 
e.g. 2-D, if you want to start the drawing in 2-D or 3-D Extruded solid, if you want to 
start your drawing by creating an extruded solid in 3-D.  

» Create processing planes (3-D only)  
Here you can specify which of the standard processing planes you want to create. 
Activate the appropriate checkbox.   
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» View projection and View representation (3-D only)  
If you want to work in 3-D, use these functions to pre-set the model view and the 
view representation.  

 

8.4.3 Load Existing Drawing 
If you have chosen Load existing drawing as start mode, you can specify whether you 
want to load the drawing via the database, the Explorer or via an interface. As with a 
new creation, you may also activate the project directly. 

 

8.4.4 Switch Start Centre Display Off 
If you activate the Switch Start Centre display off checkbox and click OK to exit the 
Start centre, the current settings will apply as the default settings for whenever you start 
HICAD again and create new drawings. The Start Centre is then no longer displayed. To 
re-activate the Start Centre display and to change the settings, choose the Activate Start 
Centre function. The changed settings will be applied when starting HiCAD again.  

If you click OK to exit the Start Centre, the current settings are used as the default 
setting if, on the other hand, you exit the Start Centre by pressing the ESC key or the  
icon, the settings are ignored.  
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9 HELiOS at a Glance 
On the way to the finished product, time expenditure, the cost situation and product 
quality can only be optimised if all departments of a company work together efficiently. 
This requires a well-structured and efficient exchange of information between the 
parties involved in the production process - from Manufacturing, Purchasing and 
Service to Marketing and Sales. 

HELiOS is a state-of-the-art PDM/PLM system providing all essential tools for an error-
free gathering, distribution and management of the data that is required for the process 
chain. Once saved, these data can be re-used within the entire company and for the 
complete product life cycle. HELiOS manages and controls all process cycles by 
regulating and monitoring the processing and transfer of these data. 

Thus, the know-how of the company will be used optimally, redundant work can be 
avoided and error sources will be eliminated. 

HELiOS combines Product, Process and Peripherals Management to form a single 
system, thus making HELiOS the knowledge reservoir of your company. 

HELiOS can be integrated in your overall CAD system or used as a stand-alone system, 
the so-called HELiOS Desktop. 

Thanks to its modular structure, HELiOS can be optimally adapted to company-specific 
requirements.  
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10 First Steps in HELiOS 
10.1 Program Call 
Start the HELiOS Desktop by double-clicking the HELiOS.EXE file in the \HiCAD\exe 

directory or via the program icon  on your Desktop. 

Default setting is the project-independent start. Please note that the list view in the 
right-hand window will not be shown when you start HELiOS Desktop for the first time. 
Select a project first and display the list view via View and then Lists. 

If you have not ended HELiOS correctly during your last session, you will receive an 
error message from the Vault Server.  

 

10.2 Registration 
The HELiOS User Management is based on the User Management of Windows. If 
several users are registered with the same Windows User Name in EDBSETUP, a login 
mask will appear when starting HELiOS Desktop.  

Name and active group enable the user to login with the rights guaranteed by the User 
Management.  

If you select a project from the Active Project drop-down list, this project will be opened 
after starting HELiOS Desktop. If you select the project-independent setting, all 
documents will be displayed. 

Start the HELiOS Desktop with Login (see below).  

To ensure that a specific project will be opened after starting HELiOS Desktop, you need 
to specify a Start Project. On the Ribbon, activate the Tools tab, then select Options, 
activate in the dialogue the General tab and choose a start project. 

 

mk:@MSITStore:D:\Dokumente%20und%20Einstellungen\sduempelmann.INT\Desktop\helios.chm::/AllgemeinesZuHeliosNext/Konfiguration_(EDBSETUP)/HELiOSKonfiguration.htm
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10.3 Login 
Use the Login  function for a new login while working with the HELiOS Desktop, e.g. 
to work with different rights without having to exit the program. 

» Activate the Login  function on the QuickAccess toolbar. 

» Select a different user.   

» If required, change the active project and confirm the new settings with Login.  
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11 How to Use the Help 
The Online Help provides you with information, descriptions and examples on all 
functions and techniques which are available in HiCAD – from 2-D and 3-D to the 
integrated PDM functionality, Sheet Metal Processing to Steel/Metal and Plant 
Engineering.  

 Please note that the scope of available functions may vary, depending on the 
configuration level of your HiCAD product. This means that some of the functions described 
in the Online Help may not be available. 
 
Since Version 2012, the Help has been available both locally (status of the installation 
DVD) and on the Internet (regularly updated) at help.isdgroup.com. Both versions of the 
Help can be called from HiCAD via the Help Topics and Information item (‚?‛ icon on 
the top right of window). You can select your preferred Online Help type via ? > Help 
Settings.   
 

 
 

You call the HELiOS Help via the HELiOS Desktop Help menu item. T 
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To be able to use the Internet version of the Help, you need to register for the ISD’s new 
company Wiki once. This will not only give you access to the new Help, but also provide 
you with many other information which will be made available shortly in the ISD Wiki 
(Forum, Download area etc.). 
 
Click Sign up in the login window of the Online Help to register. If you have already 
been registered, enter your access data and click Login to get directly to the start page 
of the Online Help.  
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Register for the ISD Wiki 
 
After clicking Sign up in the Login window of the Online Help, enter the data required 
for the ISD Wiki in the dialogue window. Confirm the security prompt and click the Sign 
up button. 
 

 
 
After the registration the dashboard of the ISD Wiki will be displayed. A message 
indicates whether you have been authenticated as an ISD customer.  
 
If you could be identified as an ISD customer, you can now directly launch the Online 
Help using your registration data.  
 
If you could not be identified as an ISD customer, please perform the steps described in 
the message.  
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12 What’s New in Version 2013? 
The following section provides you with an overview of changes, new features and 
enhancements in HiCAD 2013.  

 

12.1 Module-Comprehensive News 
» Starting the Configuration Editor 

The Configuration Editor ISDCONFIGEDITOR.EXE can now be started directly from 
The corresponding option can be accessed via  Configuration.  

» Floating Licenses 
If you have acquired a HiCAD Extension Module with the property Floating-able at 
runtime, you can activate/deactivate them during the current HiCAD session via the 
Help topics and information menu. The HiCAD Selection dialogue window will be 
displayed.  

» Complete title block 

 When filling in title blocks subsequently using the Complete title block (without 
DB) function, you can now right-click to jump one step back. Click the middle 
mouse button to cancel the function (Please note: the cursor must be placed 
outside the input window in the process).  

 When filling in title blocks subsequently using the Complete title block (with DB 
attributes) function, the text attributes will be read from the file 
SchrFe_ausAttr.DAT in the HiCAD SYS directory. Please note that the presettings 
in this file have changed in HiCAD 2013. 

» Combined output of HELiOS and HiCAD attributes 
As of HiCAD 2013, a combined use of HELiOS attributes and HiCAD attributes in title 
blocks of drawing frames will be possible. This applies to the Insert drawing frame 
function with filling in of the title block via HELiOS. This will be possible for both 
HiCAD drawing attributes and HiCAD part attributes.  

» Settings for drawing derivation 
The settings for drawing derivation can now be found in the Configuration Editor 
(ISDConfigEditor.exe) at ...> Automatic drawing derivation. 
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» Withdrawn system files 

The files 

 ALGPAR.DAT,  

 BEMPAR.DAT  

 DIMENSIONING_SETTINGS.XML 

 KRPGEN.DAT (SP1) 

 MASPAR.DAT (SP1) 

 FITTABLE_SETTINGS.XML (SP1) 

have been withdrawn. The corresponding settings from these files are now managed 
via the Configuration management (isdcongigeditor.exe).  

The files STBEMPAR.DAT and TXTANSI.DAT are no longer required and have been 
discarded in Version 1801.0. The other files have been integrated into the 
Configuration Management. 

» Performance 
Due to the optimisation of several routines, the performance for large drawings could 
be increased further. This applies in particular to the loading/saving of drawings with 
externally referenced parts, and the Hidden Line representation of large models. 

» Units of measurement 
As of HiCAD 2013, units of measurement will no longer be freely adjustable. The 
other switching options to defined units (mm, cm, dm, m, km, inch) are, of course, 
still available. 

» Design Checker 

 The mountability check of the Design Checker now also includes an insertability 
check for bolts. 

 Tests dealing with very special situations have been removed from the Design 
Checker. (SP2) 

» HiCAD Sessions  
In the dialogue window for HiCAD sessions, drawings can be opened with a double 
left-click on the file name. (SP1) 
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» Comma as decimal separator 
According to the presettings in HiCAD, a point is used as separator in decimal 
numbers. If desired, you can also enter a comma as separator - HiCAD will 
automatically convert it to a point. This also applies to formulae entered in the feature 
log. (SP1) 

» Steel Engineering with Drawing Management  
The functions for Steel Engineering with Drawing Management can now be found on 
the Drawing Management tab (previously PDM). (SP1) 

» Views in the ICN   

Use the  and  icons to expand and collapse the view structure in the Views 

window of the ICN. Use the  function to display the active view in red colour. 
(SP1) 

» Performance  

 The performance for Hidden Line calculations could be increased significantly for 
complex individual parts, e.g. parts containing complex spiral surfaces.  

 The performance for a simultaneous working with very many views (and 
dimensions) has been increased significantly (SP2). 

 The performance for the cloning of parts in large drawings and a subsequent 
updating of item numbers, e.g. in Steel Engineering, has been increased 
significantly (by Factor 6 and more).  

» Industry-specific settings for surface approximation  
Industry-specific settings for surface approximation have been preset in the 
configuration templates (CSV files) supplied with HiCAD: (SP2) 

» Presettings in FILEGRUP.DAT file  
In the FILEGRUP.DAT file, the HiCAD path Y: now has been preset to the sub-
directory CUSTOM of your HiCAD installation (SP2), e.g.: Y:d:\hicad\custom  

» Variables names  
Variables names can now consist of more than 4 characters. (SP2)  
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» Customer feedback  
You can help us increase the user-friendliness of our products even further. If you 
participate, the ISD will collect information on your use of our software, in order to 
detect trends and use patterns. This information will then be used for a constant 
optimisation of our user interface, with the aim to make the operation of our software 
as convenient and efficient as possible for our users. If you have previously not given 
you consent to the processing of your data, but want to do this now, select the 
Customer feedback function in the Help Topics and Information menu.  

» Cylinder intersection points  
Use the new point option Cylinder intersection point (CI) to determine cylinder 
intersection points, i.e. external points on pipes with are connected by mitre cuts or 
intermediate pieces. (SP2) 

» Updating of variants when opening drawing files 
If the drawing file to be opened contains parts or assemblies whose part master 
belongs to a variant for which a new index exists in the database, HiCAD will ask you 
whether you want to update the variant. You can specify in the Configuration Editor 
(ISDConfigEditor.exe) whether you want HiCAD to display this query, or if you want 
such variants always or never to be updated.  
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12.2 2-D 
» Thanks to the new Configuration Editor, the Dimensioning functions Default (2-D 

Dimensioning + Text > Process > Settings) and Reload parameter list (2-D 
Dimensioning + Text > Process > Extras) for the loading of Dimensioning 
parameters are no longer required. If you want to reload the default setting after 
making changes to the dimensioning parameters via the Dimensioning settings 
function (2-D Dimensioning + Text > Process), open the Drawing tab and select 
Others > Extras > Temporary settings > Reload). 

» Annotations  

 If you want to use Drawing attributes within an annotation, select them from the 
right listbox of the Annotation Editor. If drawing attributes are changed, the 
annotation will be automatically adjusted accordingly. 

 Text IDs from the HiCAD text service (as shown in the TEXTTABLESEDITOR.EXE) 
can now also be used in annotations. This is not realised via the Annotation Editor, 
but needs to be set accordingly via template files (FTD) that can be loaded via the 
Annotation Editor. Precede the Text ID with the string %TS. 

» Copy & Paste  
The Copy & Paste functions for 2-D parts in the context menu of the ICN do no 
longer exist. However, you can still use the functions Copy to clipboard and Paste 
from clipboard functions in the same context menu. (SP1) 
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12.3 3-D 
» Hide dimension lines 

If desired, you can hide the dimension lines in 3-D dimensionings. This applies to 
preset dimensioning settings as well as to changed dimensioning settings. Use the 
Visible checkbox in the Dimension lines tab of the Dimension settings dialogue to 
hide and show dimension lines. The hiding of dimension lines enables a 
representation of dimensionings according to DIN 86062, i.e. dimensionings with 
dimension figures, without dimension lines, projection lines and arrows. 

» Dimensioning parameters and other dimensioning settings 

 The settings for the handling of dimension base points during updating of 
drawings can now be found in the Configuration Editor (ISDConfigEditor.exe), at 
Active configuration > System settings > Annotations > Dimensioning. 

 As of Version 2008 HiCAD supports a new data model for dimensioning. When 
you load drawings from HiCAD versions (before 2008) with the current version, all 
dimensions will be converted to the new data model. The setting that defines 
whether the conversion should take place automatically, can no longer be found in 
the file BEMPAR.DAT, but in the Configuration Editor (ISDConfigEditor.exe), at ... 
> Compatibility > Annotations > Dimensioning, 3-D. 

 The file BEMPAR.DAT is no longer supported. Instead, the corresponding settings 
are now defined in the Configuration Editor (ISDConfigEditor.exe).  

 The default settings of the dimension parameters are no longer defined in the file 
Dimensioning_Settings.xml, but via the Configuration Editor, at ... > Drawing > 
Annotations > Dimensioning, 3-D > Interactive dimensions. When saving the 
parameters, the corresponding user configuration will be saved to the 
Configuration Editor. 

» Dimensioning 

 When you open the Form/Positional tolerances dialogue window, the input fields 
will be preset with the last selected values. (SP1) 

 If you close the Element type selection dialogue with Cancel, the function will be 
ended without creating the dimensioning. (SP1) 

 Dimensions and their base points can now be completely transferred from one 
part or assembly to another part or assembly. The transfer of dimensions is, 
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however, only possible for geometrically similar parts located at the same position. 
(SP2) 

» Parametric dimensions 
The setting that defines whether variables/formulas specified in the feature log should 
be displayed in parametric dimensions can now be found in the Configuration Editor, 
at ... > Drawing > Annotations > Dimensioning, 3-D). 

» Views and Representation 

 When rotating a central projection with the mouse or space mouse, the camera will 
no longer jump to the point of rotation. The dynamic zooming changes no longer 
the camera distance, but the image detail. 

 Within the framework of the new stereoscopic representation, a greater viewer 
distance will be automatically selected when you choose the Automatic central 
projection function. 

 The settings for the locking of views can now be found in the Configuration Editor 
(ISDConfigEditor.exe) at ... System settings > Visualisation > Views. 

 The stereoscopic 3-D representation opens up new possibilities for the 
presentation of your products, provided that a corresponding hardware, driver and 
3-D glasses are available. You can access the function via Views > Properties > 
Stereo. 

 When dynamically rotating views with the mouse, the context menu (RMB = 
Selection) now contains the additional Viewer distance function. The function is 
available if the active view contains a central projection. Furthermore, you have the 
option to activate the stereoscopic view. 

» Weld seams 

 Besides automatic itemisation of weld seams, HiCAD offers the option to manually 
assign weld seam numbers to weld seams via the weld seam symbol. 

 You can include details about processes, quality levels, welding positions, 
additional materials etc. in the weld seam annotations. These can be saved as 
Favourites afterwards and can then re-used at any time. 

 The default settings for text parameters in weld seam tags (Font, Height, Colour 
etc.) can now be found in the Configuration Editor, at ... > Drawing > Weld 
seams. 
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» Transform surfaces 
When moving or rotating surfaces, changing topologies will be considered. These 
functions can also be applied to freeform surfaces.  

» Text and Annotations 

 If you want to use drawing attributes in an annotation, you can select them from 
the right listbox in the Annotation Editor. When drawing attributes are changed, 
the annotation tags will be automatically updated accordingly. 

 Text IDs from the HiCAD text service (as shown in the TEXTTABLESEDITOR.EXE) 
can now also be used in annotations. This is not realised via the Annotation Editor, 
but needs to be set accordingly via template files (FTD): %TS(Textid).  

 To access this new Automatic part annotation function, activate the 3-D 
Dimensioning + Text tab and select Text > Leader  > Automatic part annotation. 
The function allows a free selection of the template file with the annotation settings 
and the use of various filters. (SP2) 

 The New pull-down menu in the Text function group of the 3-D Dimensioning + 
Text tab contains two new functions  Copy text, New point and  Copy text, 2 
points. You use these functions to copy a 3-D text. You specify the position of the 
copy either via a reference point or by means of a displacement vector. (SP2) 

» Referencing 

 The following parameter setting options that could previously be found in the 
system file ALG3DPAR.DAT: 

Save body without dimensioning when referencing 0:no, 1:yes 

Preserve dimensioning in the drawing when referencing 0:no, 1:yes 

are no longer available in HiCAD 2013. These parameters are now permanently 
set to default setting 1.  

In the system file ALG3DPAR.DAT the following lines do no longer exist: 

Create KPM file for referenced parts (Polygon model) 0:no, 1:yes - KPM - Datei bei 
referenzierten Teilen erstellen (Polygonenmodell)  
0:nein, 1:ja 

This setting is no longer required. 
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 The referencing functions are now available via Drawing > Save/Reference > 
Update.   

 The performance for the saving of referenced parts could be increased 
significantly (up to 40%, depending of type and size of drawing). 

 Messages that may displayed when when referenced parts are saved, e.g. The 
KRA file of the referenced part is newer! Or Part ... is simplified and can therefore 
not be saved. can be switched off during the current HiCAD session, by activating 
the Suppress message in this session checkbox. (SP2) 

» Data reduction   
The Part reduction - Change representatin function can now be found at 3-D 
Standard > Tools > Attr.> ... . The function also supports multiple selection. There 
you will also find the new Remove part reduction function that enables you to 
remove the reduction for all parts in a drawing. (SP1) 

» Sketches 

 Use the new Transition curve function to automatically create a curve with a 
moderated curvature (Hermite spline) between 2 points. You access the function 
via Sketch > Draw > Arc. 

 The functionality for the taking over of edges into a sketch has had a redesign. The 
corresponding functions are now available in the Take over edges menu (Sketch > 
Derive). The following functions are no longer available.  

 A preview will be shown when you select/take over edges, or create transition 
curves. (SP1) 

 The context menu for Sketches now also contains the Create part via part type 
catalogue function from the Metal Engineering tab. (SP1) 

 The functions for the creation of parallels in Sketches have been combined into 
the new Offset function. (SP1) 

 The Convert 2-D part to Sketch function as well as the functions for a taking over 
of graphical elements can now be found at Sketch > Derive > Conv... .(SP1) 

 The menu for the deletion of sketches has been revised. With the Delete edge  
function you can now delete, for example, all edges located within a selection 
rectangle, or all connected edges in one step. The older function Delete GE, 
Polyline is therefore no longer available. (SP2) 
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 The Offset function for Sketches now also enables the creation of several offsets. 
This means that the function will remain active after the creation of the first offset, 
allowing the creation of further offsets of edges using the previously specified 
distance value. You can also select edges of previously created offsets. Also new is 
the option to select lines/edges via a defined rectangle. (SP2) 

 The Convert 2-D part to sketch function can now be found in the New function 
group of the Sketch tab. (SP2)  

 The Section functions for Sketches (previously at Sketch > Process > Trim > 
Section ...) are no longer available. (SP2)  

 The functions Copy 2-D part from drawing, with transformation, Insert 2-D part 
from sketch, with transformation und Copy 2-D part from file to 3-D are no 
longer available. (SP2)  

 The Copy 2-D without transformation (Individual, Polyline, In rectangle) 
functions can now be found in the Take over edges menu. (SP2) 

 When taking over edges from a solid or a part with free edges, coincidence 
constraints are automatically assigned, if the Enter constraints option has been 
activated in the settings for Sketch HCM constraints (Sketch > HCM > Tools  > 
Settings). (SP2)   

 When dividing edges of a sketch you have now the option to specify whether 
curves are to remain curves after the division, or are to be approximated by means 
of lines. (SP2) 

» New archive format for variants 
For general feature variants an new file format (.VAA) is now available (as for part 
variants in Plant Engineering). In contrast to the previously used VAD format, variants 
in the VAA format consist of only one file and can also be stored in the Vault Server. 
To access the new functions for the management and editing of general feature 
variants of the new file format, open the Drawing tab and select Save/Reference > 
Part... ..  

» Polyhedral filleting 
Only the filleting of individual edges is now possible for polyhedral filleting. 
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» C-edge sweep 
For c-edge sweep creation, the following options are available in a listbox (SP1): 

 Minimum rotation (Corresponds to the previous setting  With direction 
specification)  

 Direction specification (Corresponds to the previous setting  With direction 
specification) 

 Constant angle with direction 

» Clone parts 
The new Rotate, Parametric with displacement function has been added to the 
Clone function group of the 3-D Standard tab. This function enables you to create 
multi-body structures by moving and rotating of cloned parts. (SP1) 

» Clean up intersection 
The new Clean up intersection function has been added to the Boolean operations 
menu. You can use this function to subtract intersecting parts from the active part. In 
contrast to "normal" subtractions, you can select the facets to which you want the 
resulting hole to be parallel. (SP1) 

» Changes in dialogues for part creation 
In the dialogues for part creation the name of the Part name field has been changed 
to Article number. The assigning of attributes remains unchanged. (SP1) 

» Change fillet radii in features  
Use the new Change fillet radii in features function to change all fillets in the feature 
log of the active part in one step. You can find the function on the 3-D Standard tab 
at Process > Fillet  > Change fillet radii in features. (SP2) 

» Change BOM-relevance  
The context menu for pars and part lists now contains the new BOM-relevance 
function that enables you to assign the BOM-relevant attribute to individual parts or 
complete part lists, or to remove this assignment again if required. (SP2)  
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» New "Types of use"  
Nnew "Types of use" are available for Steel Engineering and Metal Engineering. They 
are defined in the ASSEMBLIES table of the catalogue Factory standards > Types of 
use > STEELWORK or in the Metal Engineering table, respectively. In the 
Configuration Editor, corresponding "Type of use configurations" for drawing 
derivation have been predefined. (SP2)  

» Weight calculation for main assemblies  
Weight calculation is now also possible for main assemblies (e.g. when performing an 
itemisation, a feature recalculation of parts etc.). The weight of the main assembly 
will be assigned to the part attribute §01 and will be updated accordingly in the Part 
attributes mask. (SP2)  

» View coordinate system of active part  
You can now specify for 3-D parts whether you want the active view of derived 
drawings to be a Front view or a Top view. This influences the alignment of 
assemblies in derived drawings. The parts will be marked appropriately in your model 
drawing. If you want to remove the marking, select the Reset function.  

» Break up sub-part levels  
Special cases are parts or assemblies that have only one sub-part with a "genuine" 
geometry, i.e. surfaces, curves or isolated points. If you apply the Break up sub-part 
levels function to such parts/assemblies, the sub-parts will replace the part/assembly 
to be broken up. The following data of the part/assembly to be broken up will be 
taken over in the process. (SP2)  

» Exchange part  
When you use the Drawing > Insert Part > Exchange 3-D part function to exchange 
3-D parts, the dimensions of the part to be replaced will be assigned to the new part.. 
(SP2) 
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12.4 Steel Engineering 
» Settings in Configuration Management 

The settings in for workshop drawings can now be found in the Configuration Editor 
at  ... > Automatic drawing derivation 

» Purlin joints 

 Use the Design Variant for Purlin joints (1204) to connect one girder and one 
purlin with a folded sheet (with single or double fold), or with an L-profile that is 
bolted or welded onto the purlin and the girder. One-sided and two-sided 
connections are possible. The purlin can be any 3-D part. You can find the 
function in the Civil Engineering functions docking window, at Steel Engineering 
> General.  

 The new Design Variants for Purlin joints 1205, 1206 and 1207 enable the 
generation of further steel beam connections. (SP1) 

» Railing configurator 

 New in the Civil Engineering functions docking window is the Railing Configurator, 
a tool that allows a fast and easy creation and modification of individual railings for 
stairs. 

 Automatically derived drawings (workshop drawings) of railings created with the 
Railing Configurator can now also be dimensioned automatically. (SP1) 

 The default settings for derived drawings of railings are defined in the ISD 
Configuration Editor. Select Automatic drawing derivation > Use case-dependent, 
then select the designation of the desired component (SP1). 

 The Railing Configurator function has been renamed to Railing Configurator 
(Railings along beams). The function dialogue has been extended. For example, 
you can now also configure corner posts, and save the settings in the dialogue 
window for a later re-use. (SP2) 

 An additional Railing Configurator type is now available, which enables you to 
generate railings along straight edges- for example, railings on balcony platforms 
(solid) or concrete stairs. (SP2) 

 If you apply manual changes which are based on features to the elements of a 
railing, e.g. insert a bore or a material subtraction in a steel beam, or fillet the 
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corners of a square profile, HiCAD will try to preserve these manual changes when 
the railing is updated or modified, provided that they still make sense. (SP2) 

 The functions Railing on industrial staircase and Railing from sketch do no longer 
exist. Instead, you use the Railing Configurator (Railings along beams or along 
edges) for these tasks. (SP2) 

» K-Bracing 
Two new design variants are available for the K-bracing: K-bracing, welded and K-
bracing, bolted. 

» Derived drawing (Workshop drawing) 
In the Views for... dialogue window for derived drawings you can now arrange 
axonometric views on the left, on the right, at the top and at the bottom. Previously, 
vertical axonometries could only be placed on the left or on the right, and horizontal 
axonometries could only be placed at the top or at the bottom. (SP1) 

» Weld seams on connections 
For connections of the Type 1, you can add further information about processes, 
quality levels, welding positions, additional materials etc. to your weld seam 
annotations. These can be saved as Favourites and will then be available for re-use at 
any time (SP1). 

» Stabilizing pipe connection 
Use the new Stabilizing pipe connection (1701) Design Variant to to insert a 
stabilizing pipe connection between two beams or profiles. Possible beams or profiles 
are I-beams, U-beams and hollow profiles. (SP1) 

» Stairs in the Steel Engineeirng package 
The HiCAD Steel Engineering Package module now also contains functions for stairs. 
Please note: Since the HiCAD Steel Engineering Package is limited to 750 parts, the 
size of constructible stairs is also limited. (SP1) 

» Changes in dialogues 
The name of the Beam designation field in the dialogues has been changed to 
Article number. The assigning of attributes remains unchanged. (SP1) 
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» Changed module structure  
The Steel Engineering module does no longer contain the functions for the creation of 
stairs and railings. These functions are now available in the Steel Engineering Stairs 
+ Railings module, which is also a part of the Steel Engineering industry suites. 
(SP2)  

» Series beams with BOM-irrelevant cross-sections  
In practice, individual beams in series beam groups can consist of several different 
cross sections.These can also have different materials, which means that they must 
be hatched correctly in sectional views. In BOMs and in workshop drawings, 
however, such beams are always interpreted as 1 part. Therefore, HiCAD now also 
supports series beam groups with individual beams consisting of several, BOM-
irrelevant cross-sections. (SP2)  

» Structural analyses  
You use this function to perform structural analyses for steel and metal beams and 
profiles, e.g. cantilever beams with single loads or line loads, single-span beams with 
centred / non-centred single loads or line loads etc. The function replaces the 
Calculations function in previous versions. You will find the function on the Steel 
Engineering tab, at Further functions > Extras > Structural analysis (SP2)  

» View groups for drawing derivations 
The creation of view groups for drawing derivations (workshop drawing creation) can 
be activated or deactivated for different types of use. You specify the setting in the 
Configuration Editor (isdconfigeditor.exe) at ...> Automatic drawing derivation > 
Use case-dependent > name, with name being the name of the corresponding type 
of use, i.e. for example, BEAM (SP2) 

» Dimensioning Rule Editor  
Dimensioning rules in workshop drawings are managed via the Configuration Editor 
(isdconfigeditor.exe). For a fast and easy editing of dimensioning rules, you can use 
the new, integrated Dimensioning Rule Editor. To activate the Editor, select Further 
functions > Settings  >  Edit dimensioning rules. (SP2). 

» Front plate connection 1320 with reinforcement plates  
The Front plate connection 1320 now enables an additional insertion of 
reinforcement plates on the flange side of the traversing beam. (SP2)  
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» Pipe connections - Stiffener radius  
For Pipe connections1501, 1502 and 1503 you can now choose between an 
automatic determination of the stiffener radii, and a specification via value input. 
(SP2)  

»  New "Types of use"  
New "Types of use" are available in Steel Engineering and Metal Engineering. They 
are defined in the ASSEMBLIES table of the catalogue Factory standards > Type of 
use > STEELWORK. In the Configuration Editor, corresponding "Type of use 
configurations" for drawing derivation have been predefined. (SP2)  

» Weight calculation for main assemblies  
Weight calculation is now also possible for main assemblies (e.g. when performing an 
itemisation, a feature recalculation of parts etc.). The weight of the main assembly 
will be assigned to the part attribute §01 and will be updated accordingly in the Part 
attributes mask. (SP2) 
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12.5 Metal Engineering 
» Design variant ‘Sheet Metal corner’  

For facade sheets in the shape of "puzzle pieces", the new Sheet corner design 
variant is available in the Sheet Metal section of the Civil Engineering functions 
docking window. 

» WinISO integration  
WinIso2D is a heat flow and isothermal calculation software by the German company 
Sommer-Informatik GmbH. The WinIso2D functions can be found on the on the 
Metal Engineering tab of the HiCAD Ribbon. They support the user with the creation 
of data for WinIso calculations in HiCAD drawings. Supported are WinIso2D Standard 
Version 7.62 or higher versions. (SP2). 

» Structural analyses  
You use this function to perform structural analyses for steel and metal beams and 
profiles, e.g. cantilever beams with single loads or line loads, single-span beams with 
centred / non-centred single loads or line loads etc. The function replaces the 
Calculations function in previous versions. You will find the function on the Steel 
Engineering tab, at Further functions > Extras > Structural analysis. (SP2)  

» Types of use for Metal Engineering profiles  
Nnew Types of use are available in Metal Engineering. They are defined in the 
Assemblies table of the catalogue Factory standards > Types of use > Metal 
Engineering. In the Configuration Editor, corresponding "Type of use configurations" 
for drawing derivation have been predefined.  

» "Mullion connection" Design Variant  
The new Design Variant Mullion connection (1314) enables you to connect two series 
beams along a beam axis, similar to the Steel Engineering variant DAST-PM (405). 
(SP2)  

» New facade bolts in the HiCAD catalogue  
The User-defined fasteners catalogue contains hexagon socket head cheese-head 
bolts for Facade Engineering. (SP2) 
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12.6 Sheet Metal 
» HiCAD Unfold  

HiCAD Unfold is a special, lower-cost solution for sheet metal suppliers. This version 
enables a fast and easy reading of 3-D geometries and the creation of exact 
developments from them. The developed sheet metal product will then automatically 
be passed to your CAM solution. 

And this is what HiCAD Unfold offers: 

 External 2-D data can be loaded via DXF, DWG, Me10 or PC Draft. 3-D data can 
be imported via STEP. 

 Imported drawings are appropriately cleaned up, e.g. colours are changed, 
double, overlapping lines are deleted etc. 

 When converting solids to sheets, radii can be changed, corners can be 
processed, and the coating or processing direction can be changed. 

 HiCAD calculates the correct development and generates the entire drawing with a 
completely dimensioned blank at the push of a button. 

 The DXF interface functions for sheets enable the saving of the 2-D blank as DXF 
file, which allows a passing of the drawing to the production in a compatible file 
format.  

» Enhanced HiCAD Unfold functionality (SP2)  

 Delete 2-D elements via attributes, Delete polyline, Delete dimensioning  

 Undo and Redo 

 Integration of the Information toolbar.  

» Connecting sheet 
Use the new Connecting sheet function to connect two composite edges (guidelines) 
by a sheet. Proceed as follows:  

Use the Sketch functions to draw the composite edges (guidelines) to be connected 
later.  

The arcs of the composite edges (guidelines) will be approximated synchronously by 
polygon courses, so that two lines each lie in one plane, thus defining a flange. The 
accuracy of the resulting sheet flanges can be defined in the Accuracy criterion area.  
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Use the Preview option to check and (if required) modify your entries. 

 Bend zone runouts for connecting sheets (SP1) 
If several bend zones converge in one corner of the sheet, the sheet corner will be 
expanded, and the front faces of the bend zones will be adjusted to the adjacent 
flanges. 

» Sheet from solid (SP1) 

 The Sheet from solid dialogue window has been redesigned. The new window 
enables you, for example, to select the standard for the semi-finished product 
from the Catalogue Editor. The selection of a semi-finished product does not only 
affect he sheet thickness, but also the bend radius, the allowance method and the 
article number. If the semi-finished product checkbox has been activated, sheet 
thickness and article number cannot be modified. You can, however, change the 
bend radius and the allowance method. 
Activate the Clean up corners option to automatically process the corners of the 3-
.D part in such a way that the sheet metal parts are connected neatly and 
accurately. The same effect can be obtained with the Cut off corner function. 

 Automatically from solid (SP1) 
If you select the Automatically from solid (Unfold > Process, 3-D) function, the 
reference plane will be selected automatically after you close the window with OK.  

» Length change  

 The Lengthen flange function can now also be applied to circular shaped flanges. 
(SP1) 

 The lengthening of sheets will be highlighted in the drawing when you activate the 
corresponding feature item. The displacement vector will be displayed as an arrow 
from the start point to the end point of the vector. (SP2) 

» Hinges and Border lips (SP1)  
The functions for the creation of hinges and border lips now allow a taking over of 
bend radii from semi-finished product tables. 

» Bend zones  
There are 3 different types of bend zones in HiCAD: 

 Old Sheet Metal parts with segmented surface bend zones, 

 Old Sheet Metal parts with segmented, cylindrical bend zones, 
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 New Sheet Metal parts with cylindrical bend zones. 

When attaching a new flange to a sheet metal part, HiCAD will automatically 
recognize which bend zone type was used, and change the setting accordingly.  

» Export  

 DXF-files (SP1) 
When exporting parts as DXF files you have now the following options to support 
you with the sheet selection: All sheets, Sheets from list and Active sheet. The 
sheets must be BOM-relevant and must have an item number.  

 LVD export (SP2)  
This function enables the reading of sheet developments out of HiCAD as XML 
data for CADMAN-B (Version 7.5 or higher) by LVD.  

 Chamfers, Countersunk bores, Threads (SP1) 
If desired, you can you can suppress the export of chamfers, countersunk holes 
and thread lines via corresponding settings in the the system file ABWPAR.DAT. 

» Sheet development  
If you activate the automatic sheet development (right-click) instead of selecting the 
base sheet when developing a sheet part, the side with the processing direction 
arrow will be developed. If the sheet part has nor processing direction, the coated 
side will be developed. 

» Coating (SP2)  
The Coating dialogue now contains the last selected settings when the function is 
called again.  

» Close 2 bend zones (SP2)  
The Close 2 bend zones (drainage area) function is now also available in the Sheet 
Metal standard license.  

» Moulding tools as symbols in sheet developments (SP2)  
Moulding tools are 3-D parts. In sheet development they are displayed in Hidden 
Line representation. To display them as 2-D symbols in sheet developments you 
need to create a parameterised 2-D HCM variant of the tool and enter it in the 
Catalogue Editor.  
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» Bend zone tooling (SP2)  
The new Bend zone tooling function enables you to assign bending tools to bend 
zones. In HiCAD Sheet Metal you can specify the angle, the bend radius and the 
allowance method for bend zones. In practice, the radius depends, for example, on 
the material, the thickness, and also on the utilised bending tools. The Bend zone 
tooling function enables a practice-oriented adjustment of the radius and the 
allowance method. The data of the machine manufacturer LVD are evaluated for this 
purpose.  

 

12.7 Interfaces  
» HyperMesh plugin (SP1)  

Drawings and parts can now also be exported from HiCAD to HyperMesh.  

» Optimisation and performance increases (SP1)  

 The update to CADFix 9.0 comprises the formats ACIS R23, CATIA V5 R22, 
Parasolid V25, SolidWorks 2013 and Unigraphicas NX8. 

 For STEP export, the processing of complex structures such as spiral geometries 
has been speeded up significantly. 

 VRML and 3D PDF export now also includes the transfer of HiCAD part names. 
The 3D PDF export takes over the views form HiCAD instead of transferring them 
to a PDF standard. 

 IFC export functionality has also been redesigned and enhanced, and now also 
supports the Coordination View 2.0 subschema. 

 Bitmap graphics contained in DXF/DWG files will be transferred to HiCAD. 

» Licensing: Native converter no longer required (SP1)  
Previously, the native converter was required for the utilisation of foreign formats. As 
of version 1801, the native converter will no longer be required. This means that 
interfaces can now simply be activated via the corresponding interface modules 
without any involvement of the native converter. 

» Plugins for export to ANSYS, FEMAP,Patran 
Drawings and parts can be exported from HiCAD to ANSYS Workbench, FEMAP and 
MSC Patran.  
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» Performance 

 The performance for the processing of large drawings converted via CADFix 64 Bit 
(DXF/DWG , Step etc.) has been enhanced significantly. 

 As of Service Pack 2, the formats CATIA V5 R 23, NX 8.5 and DXF/DWG 2013 are 
additionally available. (SP2) 

 HiCAD memorizes the before mentioned formats and offers them as the new 
default setting for export processes. (SP2) 

 Furthermore, the support of Unicode characters in file names has been enhanced. 
(SP2) 

» STEP and IFC 

 STEP files can, similar to referenced HiCAD files, be subdivided into several 
interlinked STEP files, and also be loaded in this way.  

 The IFC export functionality has also been redesigned and enhanced.  

» Splines in DXF files  
Splines read from (2-D) DXF files (genuine B-Splines) will be written back as splines 
during export. If desired, you can deactivate this behaviour and export B-Splines 
from DXF files as approximated lines instead.  

» HELiOS attributes 
If you use the HELiOS database, you can write the HELiOS attributes (e.g. the 
HELiOS part name) into other file formats during export. For this to happen, you need 
to select Drawing > Others > Extras > Temporary settings > Save ICN display -On/Off, 
and confirm with Yes.  

» Configuration of import / export default options  
The import and export default options for 3-D interfaces (STEP, Iges etc.) can be 
specified in the Configuration Editor (ISDConfigEditor.exe), at ... > Active 
configuration (Base configuration) > Interfaces > General 3-D interfaces by 
activating or deactivating the corresponding checkboxes. (SP2) 

» DSTV/DSTV NC (SP2)  

 The user-friendliness of the DSTV import functionality has been improved.  

 The DSTV export now enables a shortened representation of powder marking 
lines.  
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» Attribute mapping for Cadenas PARTsolutions  
The dialogue for direct part import from Cadenas PARTSolutions has been extended. 
It now offers the option to assign HiCAD attributes to the supplied Cadenas attribute 
designations and save them in the form of a predefined table for re-use.  

» PEPS  
3-D standard processings can be transferred in an optimised quality to the NC 
programming system PEPS® of the company Camtec, where processing cycles can 
be generated automatically. Licenses and installations can be obtained from Camtek.  

» Output of ICN names for export via Plot Manager  
If desired, you can now also export the HELiOS attributes shown in the ICN when 
performing an (automatic) 3-D interface export (Step, 3D-PDF) via Plot Manager or 
the HiCAD Spooler. For further information please read the Plot Manager + Print 
Client topic in the General Information on HELiOS chapter of the HELiOS Online 
Help. (SP2) 

»  

12.8 Catalogue Editor 
» Beams, Profiles, Bolts and Screws according to Indian Standards 

The range of parts according to Indian standards  in the catalogues SEMI-FINISHED 
PRODUCTS > BEAMS+PROFILES and FASTENERS > BOLTS+SCREWS has been 
expanded significantly: 

 IS 808...  

 IS 3757 

 IS 6623 

 IS 6649 

» Further catalogue expansions 

 Disc springs according to DIN 2093 (Catalogue: FASTENERS > SPRINGS). 

 Additional hexagon bolts according to DIN EN ISO 4016  (M6X16-4.6 bis M6-28). 

 Washers according to DIN EN ISO 7094 (replacing DIN 440). 

 Copper and copper alloys  
The catalogue: MATERIALS > NON-FERROUS METALS > COPPER ALLOYS 
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provides coppers and copper alloys. The columns RM (Tensile strength) and RE 
(Stretch limit) have not been assigned any values here, as the data strongly 
depends on the respective construction method and design type. 

 Hexagon head bolts with flange according to DIN EN 1665 (formerly DIN 6921) 

 Round-head screws according to DIN EN ISO 8677  

 Dowel pins according to DIN EN ISO 8750 

 Screws according to DIN EN ISO 14580 

 Self-tapping screws according to DIN EN ISO 15481  

 Hexagon socket flat button head screws with collar according to DIN EN ISO 
7380-2:2011-11 (SP1) 

 Tapping screws according to DIN EN ISO 1479 (SP1) 

 DIN EN ISO 14581, Countersunk head screw with Torx (SP1) 

 The new material Stainless steel 1.4301 for semi-finished materials has been 
added. 

» Extended settings 
The Settings menu now contains the new Do not close tables in HiCAD function. 
Provided that your computer has enough memory, you can use this function to 
speed up HiCAD. If the setting has been activated, standard parts tables in HiCAD 
will no longer be closed during normal operation, but will remain in the memory. Up 
to 6% of operating time can be saved in this way. (SP1) 

» Transfer to HELiOS 
Further functions are available for the transfer of tables/catalogue to the HELiOS part 
master management:  

 Transfer to HELiOS, New creations without given article numbers allowed 

 Transfer to HELiOS, New creations only with given article numbers 

 Transfer to HELiOS, No new creations 

These functions can be fond in the toolbar as well as in the menus with the table and 
catalogue functions. (SP1) 
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» New "Types of use"  
New Types of use are available in Steel Engineering and Metal Engineering. They are 
defined in the ASSEMBLIES table of the catalogue Factory standards > Types of use 
> STEELWORK or in the Metal Engineering table, respectively. In the Configuration 
Editor, corresponding "Type of use configurations" for drawing derivation have been 
predefined. (SP2)  

» Synchronize catalogues  
If you want to use the same catalogue and tables as other users, you can use the 
Synchronize catalogue function in the context menu to synchronize your catalogues 
with those of other users. This can, for instance, be useful if these catalogues contain 
data that you require, but do not exist in your catalogue.  (SP2)  

» Settings in the Configuration Editor 
In the Settings menu, the functions Track changes in HiCAD and Do not close tables 
in HiCAD are no longer available. You now specify these settings via the Configuration 
Editor (SP2)  

» Anchor screws  
Weights of anchor screws have been added to the catalogue. (SP2)  

» New variants for pipe parts and gauge parts  
As of HiCAD 2013, SP2 new Plant Engineering part variants for WIKA manometer, 
HILTI pipe clamps and various ERMETO pipe parts from the PARKER catalogue will 
be available. (SP2) 

 

12.9 Feature Technology  
» New file format for feature variants 

For general feature variants an new file format (.VAA) is now available (as for part 
variants in Plant Engineering). In contrast to the previously used VAD format, variants 
in the VAA format consist of only one file and can also be stored in the Vault Server. 

» Create feature 
This function can now be accessed via Drawing > Save/Reference > Part... . 
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12.10 Viewer 
» Like drawings, 3-D parts (KRA) can now be saved in HiCAD in such a way that also 

the HELiOS attributes are shown in the Viewer. You use the function Save ICN 
display with drawing - On/Off. You access the function via Drawing > Others > Extras 
> Temporary settings. Alternatively you have the option to make this settings 
permanent via the Configuration Editor (ISDConfigEditor.exe). Select ...> System 
Settings > Load/Save and activate the Save ICN attributes in drawing checkbox 
(Default: deactivated).  

» For HiCAD parts or assemblies, you can now switch between a wireframe model (2-D 
view) and a shaded representation (3-D view). Faceted 3-D parts can also be 
displayed.  

 

12.11 Plant Engineering 
» Gauge parts 

Gauge parts are now available as a new part type in the Pipe parts selection menu. 
The part type Gauge in the Components menu does no longer exist. 

» Guidelines: Hide/Show axes 
If you have defined a greater number of axes for the routing of guidelines, the 
identification of a particular axis may be difficult owing to the multitude of axes. In 
such cases, the deactivation of axes in the axes table is also rather difficult. As of 
HiCAD 2013 you have the option to switch axes on or off that are located in the 
planes spanned by the axes of the active coordinate systems.  

» Automatically place knees on guidelines 
Like Elbows, you can also place parts of the type Knee onto individual guidelines or, 
automatically, on all corners of a guideline. In contrast to the Elbows, these parts do 
not necessarily need to be symmetrical. Therefore you can select the insertion 
direction here. 

» Load/Save points list of guidelines 
The points list of a guideline can now be loaded from / saved to a file. 
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» Link to P+ID via database 
Previously the link between a layout plan and the corresponding P+ID was created by 
saving the name of the P+ID project (RPA) in the 3-D drawing, and saving the name 
of the file belonging to the layout plan in the P+ID project. A changing of the file 
names, e.g. for modified drawings, (see Update Link) always led to a removal of the 
link. The link then needed to be created anew. 

As of HiCAD 2013 the link will be created by linking the corresponding document 
masters via the database (see New Link Types in HiCAD 2013). Files that have been 
linked in the old way will continue to function in the old way. However, you can also 
apply the new link type to them if desired.  

All new links between layout plans and P+IDs will be links via database!  

» Isometry settings: Tripod 
The Isometry settings have been expanded. On the Symbols tab you can now also 
specify the settings for the tripod indicating the orientation of the coordinate system. 
These are the arrow symbol, the magnification factor and the texts for the X-, Y-, and 
Z-direction.  

» Isometry settings: Item numbers 
Previously (i.e. before HiCAD 2013), the item numbers in the isometry were assigned 
independently of the item numbers that were globally generated by HiCAD for all 
parts. As of HiCAD 2013, various options for the generation of part item numbers in 
the isometry will be available. For this purpose, the isometry settings have been 
expanded by the Item numbers tab. 

» Parts with only one genuine connection 
Parts with only one "genuine" connection still require two named isolated points 
(Designation: ! and 2) to enable them to be auto-aligned correctly. To prevent Point 2 
to be falsely interpreted as a connection in the isometry, the attribute 
ANSCHLUSSART2 (CONNECTION TYPE2) needs to be set to the value 0. 
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» Exchange identical valves in pipelines 
Two new functions enabling you to exchange valves in pipelines are available in the 
pull-down menu of the Change function in the Pipeline Tools function group: 

» Activate part chain 
The new Activate part chain function can be found at Plant Engineering > Settings 
> Activ... . This function activates all parts of a "part chain" within a pipeline in the 
ICN.  (SP1) 

» Plant Engineering settings: Part selection 
If the Database has been selected as part data source in the on the Part selection tab 
of the Plant Engineering Settings dialogue window, two additional checkboxes for 
accessory sets will be available: Pipe class also applies to accessory set and 
Accessory set selection for each insertion. (SP1) 

» Straight pipes 
If desired, you can now assign different connection types on the ends of straight 
pipes. (SP1) 

» Several branching parts 
Several branching parts with saddle connections or straight pipes can now originate 
from a branching point on the centre line of a straight pipe. (SP1) 

» Generate pipe spool drawing 
HiCAD supports the generation of pipe spool drawings. The corresponding function 
can be found in the Isometry / Pipe spool drawing function group of the Plant 
Engineering tab. In contrast to a pipeline isometry, a so-called pipe spool drawing is 
generated from the active view of a pipeline. No new CAD drawing will be created in 
the process, but the generated drawing elements will be assigned to the active view. 
(SP1) 

» Using different accessory sets for one part 
It does not always make sense to assign a fixed accessory set to a part. For example, 
it is possible that a flange either requires, depending on the fitting situation, bolts with 
different lengths, or, depending on the temperature of the environment or the type of 
the filling medium, different seals. If the Database has been set as part data source 
in the Part selection tab of the Plant Engineering Settings dialogue window, you have 
the option to assign different accessory sets to one part. (SP1) 



What’s New in Version 2013? 

   147 

» Extended settings: Automatic dimensioning 
Owing to the new pipe spool drawing functions, the isometry settings on the 
Automatic dimensioning tab have been expanded. (SP1) 

» New part type ‚Accessory set‛ 
The processing options for accessory sets have been expanded for HiCAD 2013, SP1 
(Version 1801). To be able to use them, you need to classify the part masters of 
accessory sets (not the part masters of accessory parts!). For this you use the class 
Accessory set. If this class does not exist yet in your database, you need to create it. 
(SP1) 

» Language selection in the PAA Editor  
When you open a variant (KRA, PAA) with the PAA Editor, the language selection 
dialogue will no longer be displayed automatically. If the selected file contains no 
language information, the language ID set in the Registry will be used for this file. 
Otherwise, the language ID assigned to the file will be used (SP2)  

» Language selection for part data sychronisation  
When you perform a Part data synchronisation the language selection dialogue will 
no longer be displayed automatically. If the selected file contains no language 
information, the language ID set in the Registry will be used for this file. Otherwise, 
the language ID assigned to the file will be used. (SP2)  

» Exchanging of valves  
You can now use the functions Exchange valves, in one pipeline and Exchange 
valves, in all pipelines to exchange even valves that are not located on a guideline. 
(SP2) 

» Settings for links to P+ID  
The checkboxes When saving the layout plan also save P+ID project and When 
saving the P+ID project also save layout plan have been removed from the Link to 
P+ID tab of the Plant Engineering Settings dialogue window. An automatic saving of 
the linked P+ID project or the layout plan is therefore no longer possible. (SP2)  

» Elbows - Adjust to displacement  
The new Adjust to displacement function is now available for the insertion of elbows. 
(SP2)  
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» Branchings with Saddle connections and Pipes  
Previously, branchings could only be created from a straight pipe or the straight 
segment of a bent pipe by means of a saddle connections or a different pipe with a 
smaller diameters. Now you can also create branchings from parts of the part type T-
piece, Branch, Concentric reducer and Knee, via cylindrical sections ending in a 
connecting surface. If desired, several branchings (in different directions) can be 
created. (SP2) 

» Automatic adjustment of nominal diameter condition  
If a part is to be inserted on a guideline, HiCAD will search for a part connection - 
starting from the desired insertion point on the guideline in both directions along the 
guideline segments that are still empty. The nominal diameter of the found 
connection can be used for the search condition of the nominal diameter of the part 
to be inserted. (SP2) 

» Part information: Display accessory set  
If you use the HELiOS Database as part data source, the Part information dialogue 
window will have, in addition to the Accessory button, an Accessory set button, 
enabling you to display the part master of the accessory set. This HELiOS dialogue in 
turn allows a displaying and editing of the product structures and the part masters of 
the accessory parts.(SP2) 

» Changed setting options for flange gaskets  
Gaskets will now always be displayed as 3-D parts. The following setting options for 
flange gaskets in the Part selection tab of the Plant Engineering Settings dialogue 
window are no longer available: Only specify thickness, Gasket/seal in BOM and 
Gasket/seal as 3-D part. (SP2) 

» Reset isometry and pipe spool drawing data  
The functions Reset isometry and Reset pipe spool drawing data have been 
combined into one function. The  Reset isometry and pipe spool drawing data 
function can now be found at Plant Engineering > Isometry > Reference coordinate 
system. (SP2)  

» Pipe spool drawing: Text objects/Item number tags  
Use this function to distribute the annotation in pipe spool drawings over several 
views by assigning text objects to a different view. (SP2) 

» Isometrie: Warning if isometry becomes invalid  
If the pipeline from which the isometry was generated is contained in the isometry as 
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a referenced part (see Reference Isometries and Manage via Database), it is possible 
that the pipeline will be processed further after division of the isometry: Further parts 
might be added, or existing parts might be replaced with other parts. These parts are 
initially not assigned to any of the split isometries. Before re-generating the isometry 
from the layout plan, HiCAD therefore checks whether there are any parts which are 
not assigned to any split isometry yet. (SP2) 

» Isometry/Pipe spool drawing: Necessarily incomplete connecting point 
representation  
At multiple branchings, several types of connections can converge, which means that 
they cannot be represented by one single symbol. In such cases, an additional 
annotation tag will be attached at this connecting point - in the isometry as well as in 
the pipe spool drawing. (SP2) 

» Isometry/Pipe spool drawings: Accessory parts in BOMs  
Previously you could only access the part attributes of accessory parts. Now, you can 
also evaluate the %DBAT text keys from HELiOS. (SP2) 

» Isometry: Hide/Show dimensions  
The functions Show dimension and Hide dimension are no longer available on the 
Isometry tab. (SP2) 

» Isometry: Drawing frame  
The standard procedure in HiCAD can be applied here as well: Drawing frames with 
or without part master are possible, and the correct designation of the "SCHRIFE" 
text field "SCHRIFE" will be read from the schrfeld.dat file when the drawing frame 
object is instantiated. (SP2) 

» Connection info for multiple branchings  
If there are several branching parts starting from one branching point, the connecting 
points of these parts will lie on top of each other in the branching point. (SP2)  

» New variants for pipe parts and gauge parts  
As of HiCAD 2013 SP2, new variant files for WIKA manometers, HILTI pipe clamps, 
and various Ermeto pipe parts from the PARKER catalogue will be supplied in the 
form of Variant Archive Files (VAA files). (SP2) 

» DB link for the linking of 3-D assembly and P+ID  
The following database link 3DASSY_PID will be required for the linking of a 
referenced 3-D assembly to a P+ID. If it does not exist in your database yet , define 
the link with the HELiOS Desktop. (SP2)  
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» Linking of referenced 3-D assemblies to P+IDs  
Referenced 3-D assemblies in the layout plan can be linked to one or several P+IDs. 
(SP2) 

»  

12.12 P+ID 
» Symbol selection via name (SP1) 

The lists for the selection of a symbol, a symbol set or a library now also show the 
corresponding Designations - provided that the library was managed via the database 
when it was integrated into the P+ID project.  

» Take over, as library symbol  
Use the Take over, as library symbol function to load a P+ID symbol from the P+ID 
sheet into the Symbol Editor for processing - as if you had taken the symbol from the 
symbol library from which it originated, by means of the Load library symbol 
function. In this case, however, the symbol is taken over in the form in which it 
appeared in the P+ID, i.e. any changes made to the symbol in the P+ID will be taken 
over.  

» Open several P+IDs in different HiCAD windows  
It is now possible to open several P+IDs in different HiCAD windows. At the same 
time you can edit a symbol library in another window, and load a symbol library for 
editing in a further window. 

» Remove link function withdrawn  
The link between 3-D layout plan and P+ID can now only be removed via the Plant 
Engineering tab while the layout plan is loaded.  

» Link to P+ID via database  
Previously the link between a 3-D layout plan and the corresponding P+ID project 
was created by saving the name of the P+ID project (RPA) in the 3-D drawing, and 
saving the name of the file belonging to the layout plan in the P+ID project. A 
changing of the file names, e.g. for modified drawings, always led to a removal of the 
link. The link then needed to be created anew.  

As of HiCAD 2013 the link will be created by linking the corresponding document 
masters via the database. Files that have been linked in the old way will continue to 
function in the old way. However, you can also convert old link types to new link 
types if desired. New links will always be created via the database!  
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» Extended "Move symbol" function (SP2)  

The Move symbol, only X or Y function has been extended. It now allows an 
additional and simultaneous moving of:  

 the symbols that are linked to the selected symbol (perpendicular to the 
movement direction),  

 the assigned gauge and drive symbols,  

 the corresponding connections,  

 the pipeline and pipeline info symbols in the vicinity of the corresponding 
connections,  

 the measuring points on the corresponding connections or symbols.  

» Visualisation settings  
On the Visualisation tab of the P+ID Settings dialogue window some text have been 
changed: You can now see which layers will be shown or hidden for the hiding and 
showing of particular objects. The hiding of Layer 1 will now be prevented (checkbox 
cannot be deactivated). (SP2)  

» Own symbol lines for pipe connections (SP2)  
On the Connections tab you can specify types using symbol lines (8) for pipe 
connections.Supplied with HiCAD are symbol lines according to DIN 2448. The 
contents of this selection list are specified in the makro2d\symblinien2481_list.dat 
file.You can create further files with selection lists, which can then refer to symbol 
lines defined by the user. (SP2). 

» Linking of referenced 3-D assemblies (SP2) 

 The Link to 3-D function now also contains the linking option of referenced 3-D 
assemblies to P+IDs. If the P+ID has been linked to a referenced assembly, this 
function will load the assembly into a new window.  

 If a P+ID symbol has been linked to a 3-D part or to a pipeline in a referenced 
assembly, use the Show 3-D part function to load the referenced assembly into a 
new window.  

» Information in the ‘Switch drawing’ ICM window (SP2)  
The Switch drawing window of the ICN now also displays the project name and the 
sheet number if P+ID projects. If the P+ID is managed with HELiOS, the document 
number will be displayed. 
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» Locked RPA file (SP2)  
When loading a P+ID project without access to the HELiOS database, the RPA file 
will be locked in the file system. A lock file with the extension "RPA~Lock" will be 
temporarily generated, to record the user name and the loading time of the P+ID 
project. If a different user tries to open the P+ID project, access will be denied, and 
the user currently working on the project will be indicated. 

 

12.13 Configuration Management 
» DAT and XML system files 

As of Version 1700, HiCAD enables a central configuration management via the 
Configuration Editor tool. The aim of our further developments is a gradual transfer of 
the previously used system files with their adjustable parameter settings into the 
Configuration Editor, thus enabling a central and safe configuration management. 

This transfer has already been realised for the following files: 

 ALGPAR.DAT 

 BEMPAR.DAT 

 DIMENSIONING_SETTINGS.XML 

 KRPGEN.DAT (SP1) 

 MASPAR.DAT (SP1) 

 FITTABLE_SETTINGS.XML (SP1) 

 STBEMPAR.DAT (SP1) 

 TXTANSI.DAT (SP1) 

 STABMPAR.DAT (SP2)  

 AUBM3PAR.DAT (SP2)  

» Permission upon start of the Configuration Editor (SP2)  
The permissions to change profiles or settings depend on the behaviour of the Editor 
when it is started.  

Users without administrator rights and users with administrator rights who did not 
select the Run as administrator option upon start:  
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 In the Editor, settings can be edited in the profile of the user who is currently 
logged on Windows.  

 The switching to a different user is not possible. The selection box is greyed out.  

Users with administrator rights who have selected the Run as administrator option 
(right-click and select from context menu) upon start:  

 The administrator profile can be changed in the Editor.  

 The switching to other existing profiles is possible via the selection box, which 
enables a checking and/or changing of the configurations of various users.  

» User Management (SP2)  
The new Settings tab has been added to the User Management dialogue window. 
Use the Same configuration for all users option to switch off the User Management 
and the Permissions Management. The settings will then always be written to the 
Administrator profile. The User Management is by default deactivated when the 
configuration database is installed for the first time.   

» Search value (SP2) 
To perform a targeted search for particular entries (e.g. font or font size) in other data 
records, right-click the desired data record and select Search value. In the search 
mask you can limit the search to a particular area of the configuration structure tree, 
by activating the Limit to checkbox and selecting the area of the configuration 
structure from the drop down menu. When you click the Find button, HiCAD will 
jump to the next data record that meets the specified search criteria. You can change 
this data record if desired, and continue your search.   

» Additional information in user interface (SP2)  

 The path of the currently selected item in the configuration structure is now 
displayed in the info bar at the bottom of the Configuration Editor.  

 The version number and the name of the configuration database are now included 
in the caption of the Configuration Editor.  

 Colour, line type and font can now be selected from menus with graphics.  

 Changed values, i.e. values deviating from the underlying profile level, are marked 
appropriately and can be reset to the original default value at any time.  

» Dimensioning rules (SP2)  
Dimensioning rules in workshop drawings are managed via the Configuration Editor. 
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For a fast and easy editing of dimensioning rules, you can use the new, integrated 
Dimensioning Rule Editor. In the Configuration Editor the values offered for selection 
also contain a comment and a preview graphic. 

» Settings for Catalogues (SP2) 
At ... > System settings > Catalogue you can specify the following settings for 
catalogues in HiCAD: 

 Track catalogue changes 
Normally HiCAD checks regularly whether the catalogues are up to date. This 
automatic checking mechanism can be switched on or off. The current status 
(on/off) is entered into the Windows Registry. 

 Handling of catalogue tables 
Provided that your computer has enough memory, you can use this setting option 
to increase access speed. If this option has been activated, standard part tables 
will no longer be closed in HiCAD during normal operation, but will remain in the 
memory. This leads to time savings of up to 6%.  

» Settings for Steel Engineeeing and Metal Engineering (SP2)  
Numerous new "Types of use" are available for Steel Engineering and Metal 
Engineering - especially in connection with the new Railing Configurator. They are 
defined in the ASSEMBLIES table of the catalogue Factory standards > Types of use 
> STEELWORK or in the Metal Engineering table, respectively. In the Configuration 
Editor, corresponding "Type of use configurations" for drawing derivation have been 
predefined.  
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12.14 Variant Editor  
Since Version 2012, HiCAD has been using the format .VAA for Plant Engineering 
variants. As of Version 2013, general variants, too, can be created in this archive 
format.  

» In Version 2013, the previous Variant Editor ANVAREDIT.EXE has therefore been 
renamed to VariantenEditor.exe.  

» For Plant Engineering variants created with HiCAD 2012 or higher, and for general 
variants in the .VAA format please use only this new Editor.  

» When loading a variant, no language selection will be displayed. If the variant to be 
loaded contains no language data (this applies, for example, to general feature 
variants or to VAD files), the language ID will be applied to this variant that was 
entered for HiCAD in the Registry. Otherwise, the language ID that was assigned to 
this variant will be used. If several language IDs have been assigned, the first 
detected Language ID will be used. If you want to assign further languages to a 
variant, use the Language function. (SP2) 

» An assigned language will only be saved together with the variant if the Designation 
field is not empty. (SP2) 

» The Variant Editor now contains the new Close button. This function makes sense if 
you want to insert a variant in HiCAD, which is only possible if the variant is not open 
in the Variant Editor. In older versions, you had to close the Variant Editor first. (SP2)  

» If the Variant Editor was not closed properly, previous versions issued the message 
The interrupted process is continued after restart. This restore mechanism is no 
longer available as of SP2. Therefore, please do not forget to save your editings 
regularly! (SP2) 

»  
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12.15 Report Manager 
» The ICN docking window is no longer available in the Report Manager. (SP1) 

» The Excel export in HiCAD 2013 can be performed either via Excel templates or via 
VBS scripts. Furthermore, the supplied compatibility script enables a conversion of 
Excel templates to VBS scripts. (SP1) 

»  

12.16 Parametrics  
» Invert angle direction for angle constraints in Part HCM (SP1) 

After applying an angle constraint with the 3-D Part HCM, you have the option to 
invert the direction of the angle. 

 

12.17 Steel Engineering Drawing Management (BIM-PDM) 
» Parameters for drawing derivation in the Configuration Editor 

In the Configuration Editor (ISDConfigEditor.exe), the settings for drawing derivation 
can now be found at ... > Automatic drawing derivation  (and no longer at 
General...) . This applies in particular to the following parameters: 

 Rearrange existing views when adding new view groups, 

 AutoSync sectional views when updating PDM-managed drawings, 

 Rearrange views when updating PDM-managed drawings. 

» Configuration for BIM-PDM 
Addtional Parameters for Drawing Derivation can be found at PDM > BIM-PDM. 

» The functions for Steel Engineering with Drawing Management can now be found on 
the Drawing Management tab (formerly ‚PDM‛. (SP1) 

» Drawing derivation  

 For drawing derivations in the Steel Engineering Drawing Management you can 
now also choose the New external drawing for each drawing frame option. For 
each drawing frame a new drawing file will then be created. The derived drawings 
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will automatically be saved to the same directory where the original drawing is 
located. The file name will be composed of the prefix CD and a unique ID that is 
automatically generated by HiCAD. (SP2)  

 If you also want 3-D parts to be considered for the management of drawings, i.e. 
preserve the link Drawing up to date or Drawing not up to date, respectively, and 
use the BIM automatisms based on it, select PDM > Steel Engineering Drawing 
management > Manage general 3-D parts. (SP2)  

 

12.18  HELiOS PDM in HiCAD 
» Display of old indices in title bar (SP1) 

The index of a drawing is displayed, besides other information (e.g. the document 
number), in the HiCAD title bar. If the currently open document has an old index, 
this is indicated by a corresponding notice (Old index) in the title bar. 

» Linked Plant Engineering Isometry (SP1)  
Use the Linked drawing function of the HELiOS 3-D part context menu to load 
drawings that are linked to the active part. If the active part is a Plant Engineering 
part for which no detail drawing exists, you can also use this function to open an 
isometry linked to this part (Designation: Isometry/(...) in selection list. 

» Withdrawn system files 
The system file ALGPAR.DAT is no longer supported. The settings managed via this 
file can now be found in the Configuration Editor (ConfigEditor.exe). This also 
includes the parameter Use HiCAD/HELiOS Standard solution. 

» Opening of parts in foreign formats and insertion of standard parts saved to 
HELiOS (SP2)  
When loading drawing into HiCAD via the HELiOS document/part master, you can 
not only load drawing files in the HiCAD format (.SZA), but also drawing files which 
have been saved to the HELiOS database in foreign format (if it is a file format that is 
suitable for an import to HiCAD).  

This is also possible for standard parts saved to the database, which could previously 
only be inserted via HiCAD, but can now also be inserted via the HELiOS search 
(Drawing > Insert Part >  Insert part, via DB part master).  

»  
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12.19 HELiOS Desktop  
» HELiOS log (SP1) 

The HELiOS log is a feature that enables you to set links to HELiOS documents from 
other applications (similar to Hypertext log or File log).  
Links that have been set with HELiOS log allow for example, an opening of 
documents in the HELiOS Desktop from HTML pages or Office documents.  

» Drawing modifications for general variants (SP1) 
In accordance with the new variant archive in HiCAD 2013, all sub-types of all parts 
will be changed in case of any indexed drawing modifications for general variants. 
Each part of the variant will then be available in HELiOS as an old and a new version. 

» OR condition for part search (SP1) 
A new option that is particularly frequently required in Plant Engineering enables the 
definition of OR conditions for part search purposes. The OR condition allows you to 
search for one or several parts in two different locations at the same time, e.g. for 
both connection types in a Plant Engineering pipe class. 

» Desktop with new Look & Feel 
The HELiOS Desktop 2013 features a redesigned GUI based on WPF technology for 
maximum user-friendliness. Besides a restructured Ribbon, there is a new window 
with HELiOS options, allowing a convenient user-specific configuration and 
arrangement of result lists and views.  

» Plot Manager:  Export of HELiOS attributes, support of JT format 
HELiOS attributes (HELiOS part names) are written to the corresponding file via the 
Plot Manager during export to various formats (Step, 3D PDF, JT). A new format is 
the JT format.  

» HELiOSScan 
This new tool enables the import of scanner-generated files as HELiOS documents. 

» Optimised interfaces to other CAD system 
The functionality of the interfaces between HELiOS and the CAD systems AutoCAD, 
Inventor and SolidWorks has been redesigned and enhanced. A new automation 
interface, for example, enables a loading of documents directly from the HELiOS 
Desktop in Inventor or SolidWorks. Furthermore, new customer-specific configuration 
options are available.  
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» Link between HELiOS and ERP/PPS systems  
When transferring combined items in HELiOS PDM to an ERP/PPS systems, 
individual structure items can be re-identified via the partner system (ERP).  

» Compatibility with CAD systems 

 As of Service Pack 2 the new, expanded HELiOS Info Centre will be available not 
only for SolidWorks, but also for Autodesk Inventor. Besides displaying information 
on CAD parts, you can edit the HELioS product structure here. (SP2) 

 A new dialogue for Options and Settings for the CAD integration enables you to 
specify global settings, e.g. attribute value init values. (SP2) 

 HELiOS takes over part attributes such as material, weight, volume, density from 
SolidWorks and Inventor, IProperties and material properties of Inventor, and file 
properties of SolidWorks can be transferred to HELiOS parts and documents.  
Conversely, HELiOS part and document master data can be transferred to 
IProperties of Inventor, and to file properties of SolidWorks. (SP2) 

 In Inventor, the transfer of product structures, in addition to the part structure, can 
also take place via structure BOMs.(SP2)  

 Furthermore, an Add-in for AutoCAD 2014 will be available as of Service Pack 2. 
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